Legal Notices

Product specifications are subject to change without notice and do not represent a commitment on the part of Avid Technology, Inc.

This product is subject to the terms and conditions of a software license agreement provided with the software. The product may only be used in accordance with the license agreement.

This product may be protected by one or more U.S. and non-U.S patents. Details are available at www.avid.com/patents.

This document is protected under copyright law. An authorized licensee of Interplay may reproduce this publication for the licensee's own use in learning how to use the software. This document may not be reproduced or distributed, in whole or in part, for commercial purposes, such as selling copies of this document or providing support or educational services to others. This document is supplied as a guide for [product name]. Reasonable care has been taken in preparing the information it contains. However, this document may contain omissions, technical inaccuracies, or typographical errors. Avid Technology, Inc. does not accept responsibility of any kind for customers' losses due to the use of this document. Product specifications are subject to change without notice.

Copyright © 2017 Avid Technology, Inc. and its licensors. All rights reserved.

The following disclaimer is required by Sam Leffler and Silicon Graphics, Inc. for the use of their TIFF library:

Copyright © 1988–1997 Sam Leffler

Permission to use, copy, modify, distribute, and sell this software [i.e., the TIFF library] and its documentation for any purpose is hereby granted without fee, provided that (i) the above copyright notices and this permission notice appear in all copies of the software and related documentation, and (ii) the names of Sam Leffler and Silicon Graphics may not be used in any advertising or publicity relating to the software without the specific, prior written permission of Sam Leffler and Silicon Graphics.

THE SOFTWARE IS PROVIDED "AS IS" AND WITHOUT WARRANTY OF ANY KIND, EXPRESS, IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

The following disclaimer is required by the Independent JPEG Group:

This software is based in part on the work of the Independent JPEG Group.

This Software may contain components licensed under the following conditions:

Copyright (c) 1989 The Regents of the University of California. All rights reserved.

Redistribution and use in source and binary forms are permitted provided that the above copyright notice and this paragraph are duplicated in all such forms and that any documentation, advertising materials, and other materials related to such distribution and use acknowledge that the software was developed by the University of California, Berkeley. The name of the University may not be used to endorse or promote products derived from this software without specific prior written permission. THIS SOFTWARE IS PROVIDED "AS IS" AND WITHOUT ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, WITHOUT LIMITATION, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.

Copyright (C) 1989, 1991 by Jef Poskanzer.

Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby granted, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission notice appear in supporting documentation. This software is provided "as is" without express or implied warranty.

Copyright 1995, Trinity College Computing Center. Written by David Chappell.

Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby granted, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission notice appear in supporting documentation. This software is provided "as is" without express or implied warranty.

Copyright 1996 Daniel Dardailler.

Permission to use, copy, modify, distribute, and sell this software for any purpose is hereby granted without fee, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission notice appear in supporting documentation, and that the name of Daniel Dardailler not be used in advertising or publicity pertaining to distribution of the software without specific, written prior permission. Daniel Dardailler makes no representations about the suitability of this software for any purpose. It is provided "as is" without express or implied warranty.

Modifications Copyright 1999 Matt Koss, under the same license as above.

Copyright (c) 1991 by AT&T.

Permission to use, copy, modify, and distribute this software for any purpose without fee is hereby granted, provided that this entire notice is included in all copies of any software which is or includes a copy or modification of this software and in all copies of the supporting documentation for such software.

THIS SOFTWARE IS BEING PROVIDED "AS IS". WITHOUT ANY EXPRESS OR IMPLIED WARRANTY. IN PARTICULAR, NEITHER THE AUTHOR NOR AT&T MAKES ANY REPRESENTATION OR WARRANTY OF ANY KIND CONCERNING THE MERCHANTABILITY OF THIS SOFTWARE OR ITS FITNESS FOR ANY PARTICULAR PURPOSE.

This product includes software developed by the University of California, Berkeley and its contributors.
The following disclaimer is required by Nexidia Inc.:
© 2010 Nexidia Inc. All rights reserved, worldwide. Nexidia and the Nexidia logo are trademarks of Nexidia Inc. All other trademarks are the property of their respective owners. All Nexidia materials regardless of form, including without limitation, software applications, documentation and any other information relating to Nexidia Inc., and its products and services are the exclusive property of Nexidia Inc. or its licensors. The Nexidia products and services described in these materials may be covered by Nexidia's United States patents: 7,231,351; 7,263,484; 7,313,521; 7,324,939; 7,406,415; 7,475,065; 7,487,086 and/or other patents pending and may be manufactured under license from the Georgia Tech Research Corporation USA.

The following disclaimer is required by Paradigm Matrix:
Portions of this software licensed from Paradigm Matrix.

The following disclaimer is required by Ray Sauers Associates, Inc.:
"Install-It" is licensed from Ray Sauers Associates, Inc. End-User is prohibited from taking any action to derive a source code equivalent of "Install-It," including by reverse assembly or reverse compilation. Ray Sauers Associates, Inc. shall in no event be liable for any damages resulting from reseller's failure to perform reseller's obligation; or any damages arising from use or operation of reseller's products or the software; or any other damages, including but not limited to, incidental, direct, indirect, special or consequential Damages including lost profits, or damages resulting from loss of use or inability to use reseller's products or the software for any reason including copyright or patent infringement, or lost data, even if Ray Sauers Associates has been advised, knew or should have known of the possibility of such damages.

The following disclaimer is required by Videomedia, Inc.:
"Videomedia, Inc. makes no warranties whatsoever, either express or implied, regarding this product, including warranties with respect to its merchantability or its fitness for any particular purpose."

“This software contains V-LAN ver. 3.0 Command Protocols which communicate with V-LAN ver. 3.0 products developed by Videomedia, Inc. and V-LAN ver. 3.0 compatible products developed by third parties under license from Videomedia, Inc. Use of this software will allow "frame accurate" editing control of applicable videotape recorder decks, videodisc recorders/players and the like.”

The following disclaimer is required by Altura Software, Inc. for the use of its Mac2Win software and Sample Source Code:
The following disclaimer is required by 3Prong.com Inc.:
Certain waveform and vector monitoring capabilities are provided under a license from 3Prong.com Inc.

The following disclaimer is required by Interplay Entertainment Corp.:
The "Interplay" name is used with the permission of Interplay Entertainment Corp., which bears no responsibility for Avid products.

This product includes portions of the Alloy Look & Feel software from Incons GmbH.
This product includes software developed by the Apache Software Foundation (http://www.apache.org/).

© DevelopMentor
This product may include the JCifs library, for which the following notice applies:
JCifs © Copyright 2004, The JCIFS Project, is licensed under LGPL (http://jcifs.samba.org/). See the LGPL.txt file in the Third Party Software directory on the installation CD.
Avid Interplay contains components licensed from LavanTech. These components may only be used as part of and in connection with Avid Interplay.

Attn. Government User(s). Restricted Rights Legend
U.S. GOVERNMENT RESTRICTED RIGHTS. This Software and its documentation are "commercial computer software" or "commercial computer software documentation." In the event that such Software or documentation is acquired by or on behalf of a unit or agency of the U.S. Government, all rights with respect to this Software and documentation are subject to the terms of the License Agreement, pursuant to FAR §12.212(a) and/or DFARS §227.202-1(a), as applicable.

Trademarks
Framework, Open Media Management, Painterly Effects, Palladium, Personal Q, PET, Podcast Factory, PowerSwap, PRE, ProControl, ProEncode, Profiler, Pro Tools, Pro Tools HD, Pro Tools LE, Pro Tools M-Powered, Pro Transfer, QuickPunch, QuietDrive, Realtime Motion Synthesis, Rect-Fi, Reel Tape Delay, Reel Tape Flanger, Reel Tape Saturation, Reprise, Res Rocket Surfer, Reso, RetroLoop, Reverb One, ReVibe, Revolution, rS9, rS18, RTAS, Salesview, Sci-Fi, Scorch, ScriptSync, SecureProductionEnvironment, ServiGT, ServiLT, Shape-to-Shape, ShuttleCase, Sibelius, SimulPlay, SimulRecord, Slightly Rude Compressor, Smack!, Soft SampleCell, Soft-Clip Limiter, SoundReplacer, SPACE, SPCEShift, SpectraGraph, SpectraMatte, SteadyGlide, Streamfactory, Streamgenie, StreamRAID, SubCap, Sundance, Sundance Digital, SurroundScope, Symphony, SYNC HD, SYNC I/O, Syncronic, SynchroScope, Syntax, TDM FlexCable, TechFlix, Tel-Ray, Thunder, TimeLiner, Titansync, Titan, TL Aggro, TL AutoPan, TL Drum Rehab, TL Everyphase, TL Fauxider, TL In Tune, TL MasterMeter, TL Metro, TL Space, TL Utilities, tools for storytellers, Transit, TransJammer, Trillium Lane Labs, TruTouch, UnityRAID, Vari-Fi, Video the Web Way, VideoRAID, VideoSPACE, VTEM, Work-N-Play, Xdeck, X-Form, Xmon and XPAND! are either registered trademarks or trademarks of Avid Technology, Inc. in the United States and/or other countries.

Adobe and Photoshop are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other countries. Apple and Macintosh are trademarks of Apple Computer, Inc., registered in the U.S. and other countries. Windows is either a registered trademark or trademark of Microsoft Corporation in the United States and/or other countries. All other trademarks contained herein are the property of their respective owners.

VCenter, VMware, and vSphere are registered trademarks of VMware, Inc.

Interplay | Production Virtual Environment with VMware Best Practices Guide • Created December 20, 2017 • This document is distributed by Avid in online (electronic) form only, and is not available for purchase in printed form.
# Contents

**Using This Guide** ................................................................. 7  
Symbols and Conventions ......................................................... 8  
If You Need Help. ................................................................. 9  
Avid Training Services ............................................................ 9  

**Chapter 1 Virtual Environment with VMware Best Practices** ............. 10  
Overview ................................................................................. 10  
Qualified VMware Versions ..................................................... 13  
Minimum vSphere Environment Specifications ................................ 14  
VMware Validation Environment for Interplay Production ................. 15  
Managing Virtual Resources ..................................................... 18  
Maintaining VMs on Shared Storage .......................................... 18  
Interplay Production VM Recommendations .................................. 20  
Media Indexer VM Recommendations ......................................... 25  
MPI VM Recommendations ...................................................... 29  
Managing and Monitoring VM Resources ..................................... 30  
VMware Networking Best Practices ........................................... 31  
Best Practices for Working with Snapshots .................................. 31  

**Chapter 2 Creating Avid Interplay Production VMs** ....................... 33  
Creating a New VM with the Web Client ..................................... 33  
Powering on the VM for the First Time ...................................... 47  
Creating a Template ................................................................... 49  
Creating a Customization Specification ...................................... 50  

**Chapter 3 Creating an Interplay | Engine Failover Cluster Using VMware Hosts** .......................... 54  
Overview of Creating a Virtualized Interplay | Engine Failover Cluster ...... 54  
Create the VM Nodes .................................................................. 60  
Configure the Public and Private Network Adapters ..................... 64  
Add Shared Storage Volumes to the First Node ........................... 73  
Add Shared Storage Volumes to the Second Node ....................... 74  
Install and Configure the Microsoft Cluster Service ..................... 74  
Installing the Interplay Engine ................................................... 91  
After Installing the Interplay | Engine ......................................... 103  
Create an Interplay | Production Database .................................... 103
Test the Complete Installation .......................................................... 104
Install a Permanent License ................................................................. 105
Configure the Cluster for a vSphere HA and vSphere DRS Environment .............. 105
Using This Guide

This guide describes the supported configurations for running Interplay Production in a virtual environment using VMware® vSphere® 6. It provides details to help you select supported host servers and to optimally configure VMs for Interplay software. This guide includes detailed instructions for creating a virtualized Interplay Engine failover cluster.

This guide is intended for system administrators and other personnel who are familiar with VMware technology and the Microsoft Cluster Service.

⚠️ This guide is subject to change and is periodically updated. Before you begin an installation, check the Avid Knowledge Base for the latest version. The following Knowledge Base article contains links to documentation for each Interplay Production release:


Revision History

<table>
<thead>
<tr>
<th>Date Revised</th>
<th>Changes Made</th>
</tr>
</thead>
<tbody>
<tr>
<td>December 19, 2017</td>
<td>Added the following: “Media Indexer v3.8.2 and Later VM Recommendations” on page 25</td>
</tr>
<tr>
<td>September 14, 2017</td>
<td>Added support for vSphere v6.5 Update 1.</td>
</tr>
<tr>
<td>August 4, 2017</td>
<td>Updated RAM for Production Services + 4 Transcodes to 24 GB for single application on one VM section: “One Application per VM” on page 24</td>
</tr>
<tr>
<td>July 21, 2017</td>
<td>Updated RAM for Production Services + 4 Transcodes to 24 GB</td>
</tr>
<tr>
<td>July 6, 2017</td>
<td>Updated Capture and Router Control for the following:</td>
</tr>
<tr>
<td></td>
<td>• “Multiple Applications per VM” on page 22</td>
</tr>
<tr>
<td></td>
<td>• “One Application per VM” on page 24</td>
</tr>
<tr>
<td>June 7, 2017</td>
<td>Added the following:</td>
</tr>
<tr>
<td></td>
<td>• Updated “Qualified VMware Versions” on page 13</td>
</tr>
<tr>
<td></td>
<td>• Updated information regarding Interplay Bundle in “Working with vCPUs and RAM” on page 21.</td>
</tr>
</tbody>
</table>
|                | • New recommendation to configure all virtual volumes as Thick eager zero. See “Setting Up Virtual Drives on Interplay Production VMs” on page 21.
|                | • Updated Media Indexer information and noted that Router Control is not supported on VMs. See “One Application per VM” on page 24.            |
Symbols and Conventions

Avid documentation uses the following symbols and conventions:

<table>
<thead>
<tr>
<th>Symbol or Convention</th>
<th>Meaning or Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Note" /></td>
<td>A note provides important related information, reminders, recommendations, and strong suggestions.</td>
</tr>
<tr>
<td><img src="image" alt="Caution" /></td>
<td>A caution means that a specific action you take could cause harm to your computer or cause you to lose data.</td>
</tr>
<tr>
<td><img src="image" alt="Warning" /></td>
<td>A warning describes an action that could cause you physical harm. Follow the guidelines in this document or on the unit itself when handling electrical equipment.</td>
</tr>
<tr>
<td><img src="image" alt="User Tip" /></td>
<td>A user tip provides a helpful hint that can aid users in getting the most from their system.</td>
</tr>
<tr>
<td><img src="image" alt="Shortcut" /></td>
<td>A shortcut shows the user keyboard or mouse shortcuts for a procedure or command.</td>
</tr>
<tr>
<td><img src="image" alt="Menu Command" /></td>
<td>This symbol indicates menu commands (and subcommands) in the order you select them. For example, File &gt; Import means to open the File menu and then select the Import command.</td>
</tr>
<tr>
<td><img src="image" alt="Single-Step Procedure" /></td>
<td>This symbol indicates a single-step procedure. Multiple arrows in a list indicate that you perform one of the actions listed.</td>
</tr>
<tr>
<td><img src="image" alt="Operating System" /></td>
<td>This text indicates that the information applies only to the specified operating system, either Windows or Macintosh OS X.</td>
</tr>
<tr>
<td><strong>Bold font</strong></td>
<td>Bold font is primarily used in task instructions to identify user interface items and keyboard sequences.</td>
</tr>
<tr>
<td><strong>Italic font</strong></td>
<td>Italic font is used to emphasize certain words and to indicate variables.</td>
</tr>
<tr>
<td><strong>Courier Bold font</strong></td>
<td>Courier Bold font identifies text that you type.</td>
</tr>
<tr>
<td>Ctrl+key or mouse action</td>
<td>Press and hold the first key while you press the last key or perform the mouse action. For example, Command+Option+C or Ctrl+drag.</td>
</tr>
<tr>
<td><img src="image" alt="Pipe Character" /></td>
<td>The pipe character is used in some Avid product names, such as Interplay</td>
</tr>
</tbody>
</table>
If You Need Help

If you are having trouble using your Avid product:

1. Retry the action, carefully following the instructions given for that task in this guide. It is especially important to check each step of your workflow.

2. Check the latest information that might have become available after the documentation was published. You should always check online for the most up-to-date release notes or ReadMe because the online version is updated whenever new information becomes available. To view these online versions, select ReadMe from the Help menu, or visit the Knowledge Base at www.avid.com/support.

3. Check the documentation that came with your Avid application or your hardware for maintenance or hardware-related issues.

4. Visit the online Knowledge Base at www.avid.com/support. Online services are available 24 hours per day, 7 days per week. Search this online Knowledge Base to find answers, to view error messages, to access troubleshooting tips, to download updates, and to read or join online message-board discussions.

Avid Training Services

Avid makes lifelong learning, career advancement, and personal development easy and convenient. Avid understands that the knowledge you need to differentiate yourself is always changing, and Avid continually updates course content and offers new training delivery methods that accommodate your pressured and competitive work environment.

For information on courses/schedules, training centers, certifications, courseware, and books, please visit www.avid.com/support and follow the Training links, or call Avid Sales at 800-949-AVID (800-949-2843).
Virtual Environment with VMware Best Practices

The following topics describe best practices for an Interplay Production virtual environment:

- Overview
- Qualified VMware Versions
- Minimum vSphere Environment Specifications
- VMware Validation Environment Details
- Managing Virtual Resources
- Maintaining VMs on Shared Storage
- Interplay Production VM Recommendations
- Media Indexer v3.8.2 and Later VM Recommendations
- MPI VM Recommendations
- Managing and Monitoring VM Resources
- VMware Networking Best Practices
- Best Practices for Working with Snapshots

Overview

Virtualization of Interplay Production components provides the following benefits:

- Deploy and operate multiple Avid applications on a single physical server (e.g. Avid Interplay Production components, Avid MediaCentral Platform Services, Avid iNEWS)
- Consolidate hardware to get higher productivity from fewer physical servers
- Reduce power consumption and cooling requirements
- Simplify the process of managing IT operations
- Make it easier to deploy new versions of software in a production environment

For an overview of virtualization, see the following link:


For detailed information about VMware and vSphere, see the following link:

https://www.vmware.com/products/vsphere/
# Definition of Terms

The following table defines some of the commonly used terms associated with virtualization:

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Virtualization</td>
<td>Refers to the act of creating a virtual (rather than actual) version of something, including (but not limited to) a virtual computer hardware platform, operating system (OS), storage device, or computer network resources.</td>
</tr>
<tr>
<td>VM</td>
<td>Virtual machine</td>
</tr>
<tr>
<td>vCPU</td>
<td>Virtual CPU</td>
</tr>
<tr>
<td>ESXi</td>
<td>The OS of a VMware host server. This can refer to either the free release, or any one of the licensed editions. The same installer is used for all (same installation instance can have any of the licenses applied to it).</td>
</tr>
<tr>
<td>VMware host</td>
<td>Physical server with ESXi installed on it. Utilized for physical resources such as CPU, RAM, network, SAN connections, or local datastores.</td>
</tr>
</tbody>
</table>
| vCenter Server | A server used to administer VMware host servers or vSphere clusters. The vCenter server can be one of the following:  
  - A Windows server (physical or virtual)  
  - A virtual appliance  
vCenter provides tools and a central interface for managing all connected VMware hosts and VMs, including migration through vMotion (see the definition below). vCenter also simplifies the process of updating your hosts using the VMware Update Manager component. If the VMware Update Manager is not used, administrators must update each host manually via the command line interface (CLI). |
| Virtual appliance | A pre-configured VM that’s available for importing into an existing vSphere environment. Often using a Linux OS.                                                                                                                                                              |
| vSphere    | Combination of ESXi host servers and a vCenter Server configuration.                                                                -------------------------------------------------------------------------------------------------------------------------------------------|
| vSphere client | Windows or Mac software capable of connecting to the vSphere server. The connection is established through either a web portal (Windows or Mac) or an installed client application (Windows only).                                                                                             |
| vMotion    | Also known as a migrate task, vMotion can be used to move a live VM from one host server, or one datastore, to another without any down time. Often coupled with shared storage. Storage vMotion can be within a single host server or SAN (or group of datastores on a single SAN configuration/cluster). It can be within a single host only if the host has multiple datastores configured for use. If an administrator needs to move a VM between host servers with only local datastores, the task is only available on a “cold” (powered off) VM. |
| vSphere HA | A feature that enables a cluster with High Availability. If a host goes down, all virtual machines that were running on the host are promptly restarted on different hosts in the same cluster.  
When you enable the cluster for vSphere HA, you specify the number of hosts you want to be able to recover. If you specify the number of host failures allowed as 1, vSphere HA maintains enough capacity across the cluster to tolerate the failure of one host. All running virtual machines on that host can be restarted on remaining hosts. By default, you cannot turn on a virtual machine if doing so violates required fail over capacity. |
| MPIO       | Multi Path In/Out. A common configuration to improve performance with shared storage.                                                                                                                                                                                           |
Overview

Limitations

The following limitations apply to this release:

- The information in this document applies only to an Interplay Production environment. It does not apply to other Avid products.
- Virtualization is supported on Interplay Production v3.3 and later releases only. Virtualized Interplay Engine failover cluster is supported on Interplay Production v3.5 and later.
- Supported virtual server (VM) operating system: Windows Server 2012 R2
- VMware fault tolerance is not currently supported.
- Virtualization with Microsoft Hyper-V is not currently supported.

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>IOPS</td>
<td>Input/Output Operations Per Second. A unit of measure for datastores (local or shared).</td>
</tr>
<tr>
<td>virtual core</td>
<td>Similar to the concept of physical processors cores and sockets, a virtual core is a subdivision of a virtual socket. For example, an Intel E5-2640 v3 Xeon processor has 8 cores per processor. A VM can be configured to have X virtual cores per virtual socket allocated to it. Such as 2 virtual sockets with 2 virtual cores each, giving the VM 4 vCPUs.</td>
</tr>
<tr>
<td>LUN</td>
<td>Logical unit number. A reference to a logical grouping of drives.</td>
</tr>
<tr>
<td>VMXNet3</td>
<td>VMXNET Generation 3. This is a virtual network adapter designed to deliver high performance in virtual machines (VMs) running on the VMware vSphere platform. VMXNET3 has the same features as the VMXNET2 adapter but with added functionality to minimize I/O virtualization overhead. To enable VMXNET3, VMs need to be on virtual hardware version 7 or later and may need VMware Tools installed, depending on which guest operating system (guest OS) is being used. VMXNET3 allows for 10 Gb (or higher) network speeds. If the VMware host’s network adapter is not capable of 10 Gb speeds, two VMs located on the same host can still take advantage of the higher bandwidth as the network traffic is not leaving the host server.</td>
</tr>
</tbody>
</table>
Qualified VMware Versions

VMware vSphere 6.0 Update 2 (6u2) is the minimum supported version for Avid Interplay Production in a virtual environment. vSphere 6.5 Update 1 (6.5u1) is also supported.

This does not mean that customers running version 5.5u2 need to upgrade their entire environment to version 6u2 or 6.5u1. As long as the vCenter server is on version 6u2 (or later versions of v6 or v6.5) the hosts running Avid software can be upgraded to newer versions (or brought into the configuration as new installs). Any host server that is not running an Interplay Production VM can remain at the previous vSphere/ESXi release and coexist within the configuration. For complete details regarding VMware version compatibility, see https://www.vmware.com/.

Access and setup can be accomplished through either the installable vSphere client (also known as the thick client), or the web (thin) client. Note that the thick client can connect to the vCenter server or the ESXi host server. The web client can only connect to the vCenter server.

**Prior versions of this document listed vSphere 6 (no update) as the minimum version. While v6.0 is still supported for existing Interplay Production VMs, Avid requires VMware vSphere 6 Update 2 or v6.5 Update 1 for all new installations and strongly recommends upgrading existing environments due to critical fixes included in the update.**

For more information, see http://pubs.vmware.com/Release_Notes/en/vsphere/60/vsphere-esxi-60u2-release-notes.html or https://docs.vmware.com/en/VMware-vSphere/6.5/rn/vsphere-esxi-651-release-notes.html and the following VMware KB article: https://kb.vmware.com/selfservice/microsites/search.do?cmd=displayKC&docType=kc&externalId=2129176

If you encounter an issue in the vSphere or vCenter software that is addressed by a VMware update, Avid might require you to upgrade the VMware environment.

Whenever planning an upgrade to the VMware software, you should make sure to plan for the appropriate down-time. Upgrades often require one or more reboots of the VMware servers. Additionally, Avid recommends taking a snapshot of the vCenter Server before any update. See “Best Practices for Working with Snapshots” on page 31.

Avid recommends applying security patches to the VMware host servers on a quarterly basis (at minimum). If higher security risks are identified, shorter intervals of time are recommended.
## Minimum vSphere Environment Specifications

The following table lists the minimum vSphere environment specifications for running Avid Interplay Production Servers as Virtual Machines. When purchasing a system, use the following specifications, their equivalent, or better. For optimal performance, Avid recommends that you meet or exceed the specifications listed in “Host Server VMware Validation Configuration” on page 15. In general, follow VMware best practices when setting up a system.

<table>
<thead>
<tr>
<th>Specification</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processor</td>
<td>Intel Xeon E5-2640. E5-2600 v3 is recommended and v4 is highly recommended.</td>
</tr>
<tr>
<td>Number of Processors</td>
<td>2 physical sockets per host. Set processors to performance options. Do not use power saving settings.</td>
</tr>
<tr>
<td>RAM</td>
<td>Sufficient to provide requirements without exceeding 75% of RAM installed in host server.</td>
</tr>
<tr>
<td>Datastore/storage (VM storage location)</td>
<td>Varies depending on actual servers/services being used.</td>
</tr>
<tr>
<td>Network connections</td>
<td>Be able to provide a 1GbE connection per Avid Interplay Production VM. This can be a group of 1 Gb, or one or more 10 Gb connections, depending on your environment. If possible, Avid recommends using a group of 10Gb connections for maximum throughput.</td>
</tr>
<tr>
<td>Operating system</td>
<td>VMware vSphere 6 Update 2 (includes ESXi and vCenter) is the minimum supported version. vSphere 6.5 Update 1 is also supported. For additional information, see “Qualified VMware Versions” on page 13. vCenter (Standard) server is available as software installation for a Windows Server / VM or as a virtual appliance provided by VMware. Avid highly recommends running vCenter as a Windows VM rather than the VMware virtual appliance.</td>
</tr>
</tbody>
</table>
VMware Validation Environment for Interplay Production

This section lists the specifications for the hosts servers and SAN used for the Avid VMware validation environment. Avid followed the VMware best practices for setting up the validation environment.

Host Server VMware Validation Configuration

Avid used the Dell PowerEdge R730 as a validation system for the host server and the vSphere cluster. The following table lists the technical details of the server:

<table>
<thead>
<tr>
<th>Specification</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processor</td>
<td>Intel Xeon E5-2640 v3</td>
</tr>
<tr>
<td>Form factor</td>
<td>A 2U system (R730) was used for testing to allow greater flexibility for adding PCI cards and extra drives.</td>
</tr>
<tr>
<td>Number of Processors</td>
<td>2</td>
</tr>
<tr>
<td>Processor Base Frequency</td>
<td>2.6 GHz</td>
</tr>
<tr>
<td>Number of Cores</td>
<td>8 per processor</td>
</tr>
<tr>
<td>Number of Threads</td>
<td>16 per processor</td>
</tr>
<tr>
<td>Intel Smart Cache</td>
<td>20 MB</td>
</tr>
<tr>
<td>QPI Speed</td>
<td>8 GT/sec</td>
</tr>
<tr>
<td>RAM</td>
<td>128 GB DDR4 RDIMM - ECC</td>
</tr>
<tr>
<td>Drives</td>
<td>Tested with SAN instead of internal drives</td>
</tr>
<tr>
<td>PCIe 3.0 Slots</td>
<td>6</td>
</tr>
<tr>
<td>Power Supply</td>
<td>Dual, Hot-plug, Redundant Power Supply (1+1), 495W</td>
</tr>
<tr>
<td>Networking</td>
<td>QLogic 57800 2x10Gb SR/SFP+ + 2x1Gb BT Network Daughter Card, with SR Optics for the following</td>
</tr>
<tr>
<td></td>
<td>• iSCSI SAN: Qualified with Dual 10GbE w/SFP + CNA (iSCSI offload). Note that SAN connections will depend on the site SAN configuration.</td>
</tr>
<tr>
<td></td>
<td>• vMotion and Host Management: Dual 1GbE for each</td>
</tr>
<tr>
<td>Intel i350 quad port 1GbE NIC</td>
<td></td>
</tr>
<tr>
<td>Additional NICs tested:</td>
<td>• QLogic 57810 DP 10Gb SR/SFP+ Converged Network Adapter, with SR Optics</td>
</tr>
<tr>
<td></td>
<td>• Mellanox MT27500 ConnectX3</td>
</tr>
<tr>
<td>Operating system</td>
<td>VMware ESXi 6</td>
</tr>
</tbody>
</table>
SAN VMware Validation Environment Configuration

This section lists the specifications for the EqualLogic PS6210X used for VMware validation.

<table>
<thead>
<tr>
<th>Model</th>
<th>EqualLogic PS6210X configured as RAID 50</th>
</tr>
</thead>
<tbody>
<tr>
<td>RAID Controller</td>
<td>Dual controllers with 16GB non-volatile memory per controller</td>
</tr>
<tr>
<td>Network Interfaces</td>
<td>10GbE connectivity</td>
</tr>
<tr>
<td>Management network</td>
<td>One (1) 100BASE-TX per controller</td>
</tr>
<tr>
<td>Interface ports</td>
<td>Two (2) 10GBASE-T with RJ45 or two (2) 10GbE SFP+ for fibre or twin-ax copper cabling per controller</td>
</tr>
<tr>
<td>Cache level</td>
<td>16GB per controller</td>
</tr>
<tr>
<td>Controller configured</td>
<td>active/standby</td>
</tr>
</tbody>
</table>

One controller is active, the second is standby. Ports on the active controller are fully active while connections are good. If one port on the active controller loses its connect, its mirror on the standby controller becomes live. Maximum configured transfer rate is 20Gbps from SAN.

| Drives | 24 total hard drives (2 configured as spares). Configured RAID 50. Total available size is of approximately 17 drives providing 14.1 TB of space. 22 spindles are available for performance of array (spares are not “online” for capacity/use). Drives are 2.5 inch; 10,000 RPM; 12Gb/s SAS drives (Seagate ST900MM0006 Enterprise Performance 10K HDD) For details on the Seagate drives used, see the following link: http://www.seagate.com/internal-hard-drives/enterprise-hard-drives/hdd/enterprise-performance-10K-hdd/ |

For details on the EqualLogic PS6210X, see the following link:


VMware Validation Environment Details

The following list provides details for each VMware host and iSCSI SAN used by Avid for validating Interplay Production applications on ESXi.

- Dual SD card module (2 x 16GB) set in mirrored configuration
- iDRAC8 Enterprise configured with IP addresses and local user accounts
- ESXi 6 installed on the Dual SD card module inside the host servers
- Management network configured with Dual 1GbE ports. vMotion with Dual 1GbE ports
- Assigned Enterprise Plus license on all three host servers.
- Each host was configured to use SysLog datastore (10GB) for host server log files. This was necessary due to the use of the SD module for ESXi installation.
- iSCSI SAN connected up to host servers via S4810 (10GbE) switch. With QLogic 57800 10GbE ports (two per host) optimized for MPIO.
- The SAN validation system presented four 1TB LUNs configured as a datastore cluster within vCenter. Storage DRS is set to fully automated.
VMware Validation Environment Configuration

The following illustration shows the validation environment configuration. In the PDF version of the guide, zoom in on the illustration to view details.

This illustration shows one possible combination of network configuration. This may, or may not, be a 100% match for your environment. Consult your network team to properly design the layout. Redundancy for network connections is highly recommended to avoid bandwidth limitations, contentions, and possible failures.

The following items apply to the graphic:

- vMotion and Host Management traffic run over one VLAN with two (1Gb) pNIC connection each.
- iSCSI traffic must be isolated to its own VLAN (10Gb connections). SAN will have 4 10Gb connections (active/standby) going to 10Gb switch.
- 2 10Gb ISIS connections are configured for each host.
- Host servers use dual 10Gb QLogic 57800 connections for iSCSI.

1 GbE connections for Management and vMotion are shown in the previous illustration. Depending on environment and other design factors, 10 GbE connections can be used. If 10 GbE connections are used, be sure to have enough bandwidth to support vMotion tasks without impacting production servers. Avid recommends changing the LOM/onboard card to a Quad 10GbE configuration (such as the QLogic 57840s within the Dell R630/730 servers) along with the Dual 10GbE PCI card.
Managing Virtual Resources

A VM (also referred to as a virtual machine or a virtual server) contains the following basic components:

- An OS on a virtual disk
- Virtual memory
- vCPUs
- A virtual network adapter

As long as the host resources are not oversubscribed, multiple VMs can run on the same host server. Host hardware and VM resource requirements can vary greatly, so the number of simultaneous virtual machines can also vary. System administrators must monitor resource usage to determine if the host can support additional VMs.

In the Avid validation scenario, the SAN contains the physical drives that are presented as four 1 TB LUNs. Then vCenter takes the LUNS and uses them as datastores for the VMs.

Physical servers often benefit from more CPU resources than are needed without showing any negative effects. However, this is not the case for VMs. There are many cases where allocating more vCPUs actually results in performance degradation, especially if the applications on the VM are not multi-threaded. When creating virtual machines, best practices suggest allocating the minimum amount of resources to the VM and increasing the resources as needed. This means that you generally want to allocate fewer vCPUs to the VM than you might want to (initially).

Maintaining VMs on Shared Storage

The following illustration shows an example of Interplay Production applications installed across six VMs with three hosts servers and a shared storage system. Actual VM resource assignment across hosts can vary. This is just one example. For the Avid validation configuration, VMs were spread across three Dell R730 host systems and the SAN was an EqualLogic PS6210X configured as RAID 50.
This method has the following benefits:

- All the files that make up the VM are on the SAN. vCenter manages how the VMs use the host servers.
- vCenter can automatically load balance the servers and you can also use the vCenter application to manage the balancing yourself. Options are fully automated, partially automated, and manual.
- If a host server goes down, vCenter can be configured to automatically shift the VMs’ compute resources to another host server. This includes the vCenter VM.
- Host servers do not need to contain hard drives. ESXi can be installed on flash media.

Be aware of the following drawbacks if you store the VMs on the individual host servers:

- You store the VMs on the individual host servers. Relies on RAID card configuration options selected for performance.
- You must manually balance the VMs between the host servers. Moving a VM from one server to another requires that you shut down the VM and manually migrate the VM to the other host server.
- If a host server goes down, you lose access to the VMs that were running on that host until the host is restored.
Interplay Production VM Recommendations

This section provides information for creating VMs with Interplay Production applications.

Host Server and SAN Specifications

For host server recommendations, see the configuration listed in “Host Server VMware Validation Configuration” on page 15. If you are not using a SAN and are using local storage, Avid recommends the following:

- For internal drives on a single standalone host: 8 10K or 15K RPM 2.5-inch SAS drives using a Hardware RAID controller, configured as RAID 10, with NVRAM of 1GB or greater. For example, Dell PERC H730.

For SAN recommendations, see “SAN VMware Validation Environment Configuration” on page 16. As with the Host server specifications, Avid recommends an equivalent or better system, or one that can provide the performance the Avid VMs require.

Network Adapters

The following network adapters are qualified and recommended:

- QLogic 57800, 57810, 578x0 (includes the 57840), QLE3442 (not for iSCSI), QLE8442
- Mellanox ConnectX 3
- Cisco UCS VIC 1340 (or 13x0) plus UCS 2208XP Fabric Extenders

The following network adapters are not supported:

- Intel X520
- Myricom Myri-10G

Common VM Settings

The following settings are common recommendations across all configurations:

- Enable “Memory Hot Plug” so that you can dynamically allocate RAM to the VM without shutting it down.
- If your vCPU allocation is less than the total core-count of one of the host server sockets, enable “Hot Add” so that you can dynamically allocate vCPUs without shutting down the VM. If your vCPU count exceeds the total core-count of one of the host server sockets, do not enable this feature.
  Do not count logical processors (as shown when counting hyper threading) in this computation. Only use pure hardware core count.
- When determining the number of cores, each virtual socket should include two virtual cores. For example a VM configured for 8 vCPUs would consist of 4 sockets, each with 2 cores.
  This recommendation is to allow for smaller increases in a Hot Add environment. If you have not enabled the hot add feature, you can add more cores per socket. However, the core count should always be an even number.
- Make sure that the VMware tools are installed and up to date.
• VMXNET 3 is the required network adapter for all virtual machines.
• To protect your most sensitive virtual machines, deploy firewalls in virtual machines that route between virtual networks with uplinks to physical networks and pure virtual networks with no uplinks.

Setting Up Virtual Drives on Interplay Production VMs

Interplay Production physical servers typically have two drives.
• One drive (C:) to install the application software
• A second drive (D:) for the Interplay Engine database (non-cluster configuration) or as temporary storage for the application installers

The following table lists the recommendations for the virtual drives. For maximum performance, Avid highly recommends using Thick Provisioned, Eager Zero for all Avid Interplay Production virtual drives. This applies to volumes created on both local storage and shared storage arrays. For more information and recommendations, contact your Avid Sales Representative.

<table>
<thead>
<tr>
<th>Applications</th>
<th>Virtual C:\ drive</th>
<th>Virtual D:\ drive</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interplay Engine (non-clustered)</td>
<td>80 GB</td>
<td>500 GB</td>
<td>D:\ drive is for the Interplay Production database</td>
</tr>
<tr>
<td>Media Indexer</td>
<td>500 GB</td>
<td>50 GB</td>
<td>Media Indexer uses the C: drive for database and log storage.</td>
</tr>
<tr>
<td>All other Interplay Production application VMs</td>
<td>80 GB</td>
<td>50 GB</td>
<td></td>
</tr>
</tbody>
</table>

For information on virtual drives for an Interplay Engine failover cluster, see “Add Shared Storage Volumes to the First Node” on page 73.

Software Licensing

Interplay Production v3.3 introduced software licensing, which eliminates the need for dongles. Information on using software licensing is included in the Interplay | Production Software Installation and Configuration Guide for v3.3 and later.

Working with vCPUs and RAM

The two sections included here list recommendations for running multiple applications on one VM and for running single applications on a single VM. For additional information on adding vCPUs and RAM, see “Managing Virtual Resources” on page 18. For optimum performance of your VMs, contact your Avid Sales Representative.
Multiple Applications per VM

The following table lists recommendations for combining applications. Applications are grouped together based on their relationship to each other in the Interplay Production environment.

Applications can be grouped differently depending on the workflow at the site and the amount of load placed on individual applications. Consult your Avid representative for workflow related issues. For additional information on allocating vCPU resources, see “Managing and Monitoring VM Resources” on page 30.

<table>
<thead>
<tr>
<th>Applications Running on Single VM</th>
<th>vCPUs</th>
<th>Memory</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interplay Engine, Media Indexer,</td>
<td>4 vCPUs</td>
<td>32 GB RAM</td>
<td>MI v3.6.x and later</td>
</tr>
<tr>
<td></td>
<td></td>
<td>12GB RAM</td>
<td>MI v3.5 and earlier</td>
</tr>
<tr>
<td>MI v3.6.x and later</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MI v3.5 and earlier</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Combining MI and Interplay Engine</td>
<td></td>
<td></td>
<td>Combining MI and Interplay Engine on the same VM is no longer recommended for new installations. See “Combining Interplay Engine and Media Indexer on the same VM” on page 23.</td>
</tr>
<tr>
<td>on the same VM is no longer</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>recommended for new installations.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>See “Combining Interplay Engine</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>and Media Indexer on the same VM”</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>on page 23.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Production Services Engine and</td>
<td>8 vCPUs</td>
<td>24 GB RAM</td>
<td>Anti-affinity rule b</td>
</tr>
<tr>
<td>4 Transcode Services</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>STP Encode, Delivery, Delivery</td>
<td>4 vCPUs</td>
<td>12 GB RAM</td>
<td></td>
</tr>
<tr>
<td>Receiver, Auto Production Services,</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Production Automation Service</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Interplay Transfer, ASF, ISIS</td>
<td>2 vCPUs</td>
<td>12 GB RAM</td>
<td></td>
</tr>
<tr>
<td>client</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Archive/Restore providers, MCDS</td>
<td>2 vCPUs</td>
<td>12 GB RAM</td>
<td></td>
</tr>
<tr>
<td>(MediaCentral Distribution Service)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Interplay Consolidate service</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Copy and Move Providers.</td>
<td>2 vCPUs</td>
<td>12 GB RAM</td>
<td>Affinity rule c</td>
</tr>
<tr>
<td>ASF</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ISIS client</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Interplay Capture and Router</td>
<td>4 vCPUs</td>
<td>12 GB RAM</td>
<td>Capture v3.8 and Router Control v3.8 and later. Windows 7 Compatibility Mode is not required.</td>
</tr>
<tr>
<td>Control</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Additional Interplay server</td>
<td>2 vCPUs</td>
<td>12 GB RAM</td>
<td></td>
</tr>
<tr>
<td>applications such as LUS, Transfer</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cache, Interplay Web Services</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DNS, AD, DHCP</td>
<td>2 vCPUs</td>
<td>8 GB RAM</td>
<td>These applications can be added as an extra VM depending on IT department policy,</td>
</tr>
<tr>
<td>a. During testing the Transcode services consumed 8 cores of processing power equal to 50% of total host CPU resources.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>b. Anti-affinity rule: Two different Transcode VMs should not coexist on the same host</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>c. Affinity rule: Copy and Move VMs can only exist on a host server that contains a dedicated 10 Gb port group.</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Combining Interplay Engine and Media Indexer on the same VM

A configuration that combines an Interplay Engine and Media Indexer on the same hardware system or VM is referred to as an Interplay Bundle. Installing an Interplay Bundle on a single VM is no longer recommended for new installations. It is a more efficient use of resources to give each application its own VM.

Existing installations can continue to use an Interplay Bundle on a single VM if the site meets the following requirements:

- Maximum Interplay concurrent client count = 30
  Concurrent client count refers to applications that need to log in and perform asset management functions such as check in, check out, and search. The current number of connections relevant for an Interplay Bundle configuration is basically the amount of connections displayed in the Interplay Administrator application. Click Server > Server Information and check the “Number of Connected Clients”.

- Recommended maximum number of data sources loaded into the MI database = 500,000.
  The term data sources basically represents the number of files monitored by the Media Indexer. You can get an estimate of the number of data sources by viewing the Statistics tab on the Media Indexer web interface. For all MI v3.x versions, you can also obtain a rough estimate by combining the Files count values in the Storage Statistics and AMA Storage Statistics views.

- Recommended maximum number of shared storage workspaces monitored by Media Indexer = 20

Interplay v3.7.x is the last release that supports running an Interplay Bundle on a VM.
One Application per VM

This section shows the recommended configurations when running one application per VM. In the case of Transcode, there are either two or four Providers running on the same VM. For additional information on allocating vCPU resources, see “Managing and Monitoring VM Resources” on page 30.

<table>
<thead>
<tr>
<th>Application</th>
<th>Small/Large Broadcast or Post Site</th>
<th>Network Interface</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interplay Engine</td>
<td>4 vCPUs</td>
<td>12 GB RAM/32+ GB RAM/</td>
<td>1 Gb&lt;sup&gt;a&lt;/sup&gt; Search performance may improve by adding additional vCPUs. Add 2 vCPUs at a time.</td>
</tr>
<tr>
<td>Interplay Archive Engine</td>
<td>2 vCPUs</td>
<td>12 GB RAM</td>
<td>1 Gb</td>
</tr>
<tr>
<td>Media Indexer</td>
<td>See “Media Indexer VM Recommendations” on page 25</td>
<td>1 Gb</td>
<td></td>
</tr>
<tr>
<td>Production Services Engine</td>
<td>2-4 vCPUs</td>
<td>12 GB RAM</td>
<td>1 Gb</td>
</tr>
<tr>
<td>Transcode service 2 Providers</td>
<td>4 vCPUs</td>
<td>12 GB RAM</td>
<td>1 Gb Anti-affinity rule&lt;sup&gt;b&lt;/sup&gt;</td>
</tr>
<tr>
<td>Transcode service 4 Providers</td>
<td>8 vCPUs&lt;sup&gt;c&lt;/sup&gt;</td>
<td>24 GB RAM</td>
<td>1 Gb Anti-affinity rule</td>
</tr>
<tr>
<td>Copy provider</td>
<td>2-4 vCPUs</td>
<td>12 GB RAM</td>
<td>10 Gb Affinity rule&lt;sup&gt;d&lt;/sup&gt;</td>
</tr>
<tr>
<td>Move provider</td>
<td>2-4 vCPUs</td>
<td>12 GB RAM</td>
<td>10 Gb Affinity rule</td>
</tr>
<tr>
<td>Delivery provider</td>
<td>2-4 vCPUs</td>
<td>12 GB RAM</td>
<td>1 Gb Providers sending multiple jobs at the same time may require at least 4 vCPUs.</td>
</tr>
<tr>
<td>Delivery Receiver provider</td>
<td>2-4 vCPUs</td>
<td>12 GB RAM</td>
<td>1 Gb See above.</td>
</tr>
<tr>
<td>Archive provider</td>
<td>2-4 vCPUs</td>
<td>12 GB RAM</td>
<td>1 Gb See above.</td>
</tr>
<tr>
<td>Restore provider</td>
<td>2-4 vCPUs</td>
<td>12 GB RAM</td>
<td>1 Gb See above.</td>
</tr>
<tr>
<td>Interplay Capture</td>
<td>4 vCPUs</td>
<td>12 GB RAM</td>
<td>1 Gb Capture v3.8 and Router Control v3.8 and later can be run on the same VM using 4 vCPUs.</td>
</tr>
<tr>
<td>Router Control&lt;sup&gt;e&lt;/sup&gt;</td>
<td>4 vCPUs</td>
<td>12 GB RAM</td>
<td>1 Gb</td>
</tr>
<tr>
<td>Interplay Web Services</td>
<td>2 vCPUs</td>
<td>12 GB RAM</td>
<td>1 Gb</td>
</tr>
</tbody>
</table>

<sup>a</sup> All Virtual NIC connections use VMXNET 3 protocol
<sup>b</sup> Anti-affinity rule: Two different Transcode VMs should not coexist on the same host
<sup>c</sup> During testing the Transcode services consumed 8 cores of processing power equal to 50% of total host CPU resources.
<sup>d</sup> Affinity rule: Copy and Move VMs can only exist on a host server that contains a dedicated 10Gb port group.
<sup>e</sup> Capture v3.8 and Router Control v3.8 and later do not require Windows 7 Compatibility Mode.
Media Indexer VM Recommendations

This section describes the vCPU and RAM recommendations for Media Indexer.

Media Indexer v3.5 and v3.4.3 VM Recommendations

The following table shows the vCPUs and RAM recommendations for a given number of data sources monitored by Media Indexer v3.5 or v3.4.3. To estimate the number of data sources for Media Indexer v3.5 and v3.4.3, add the Files values in the Storage Statistics and AMA Storage Statistics views of the Media Indexer web interface.

<table>
<thead>
<tr>
<th>Storage Statistics &gt; Files + AMA Storage Statistics &gt; Files</th>
<th>Recommended vCPUs</th>
<th>Recommend RAM for MI v3.5 or v3.4.3</th>
</tr>
</thead>
<tbody>
<tr>
<td>100K</td>
<td>4 vCPUs</td>
<td>12 GB</td>
</tr>
<tr>
<td>150K to 500K</td>
<td>8-10 vCPUs</td>
<td>16 GB</td>
</tr>
<tr>
<td>500K to 1 million</td>
<td>10 vCPUs</td>
<td>16 GB</td>
</tr>
<tr>
<td>1 million to 5 million</td>
<td>12 vCPUs</td>
<td>16 GB</td>
</tr>
</tbody>
</table>

Media Indexer v3.8.2 and Later VM Recommendations

This section describes how to determine the vCPU and RAM allocation for Media Indexer v3.8.2 and later. Note that Media Indexer v3.6.x and later requires additional RAM because of the addition of the MongoDB database. In addition, Media Indexer v3.8.x adds memory management features and communication improvements between the Media Indexer servers.

Media Indexer v3.8.2 and later is recommended for Interplay v3.6 and later systems. You can use a Media Indexer v3.8.2 server with MI v3.7.x clients. This allows you to upgrade the clients as time allows.

The following table shows the vCPUs and RAM recommendations for a given number of data sources monitored by a Media Indexer. For a description of the term data sources, see the Interplay Best Practices Guide.

<table>
<thead>
<tr>
<th>MongoDB Information/Items Count (data sources)</th>
<th>Recommended vCPUs</th>
<th>Recommend RAM for MI v3.8.2 and Later</th>
</tr>
</thead>
<tbody>
<tr>
<td>100K</td>
<td>4 vCPUs</td>
<td>32 GB</td>
</tr>
<tr>
<td>150K to 500K</td>
<td>8-10 vCPUs</td>
<td>32 GB</td>
</tr>
<tr>
<td>500K to 1 million</td>
<td>10-12 vCPUs</td>
<td>32 GB</td>
</tr>
<tr>
<td>1 million to 2.5 million</td>
<td>12-14 vCPUs</td>
<td>64 GB</td>
</tr>
<tr>
<td>5 million</td>
<td>12-14 vCPUs</td>
<td>120 GB</td>
</tr>
<tr>
<td></td>
<td></td>
<td>or 86 GB using vmoptions</td>
</tr>
</tbody>
</table>
Media Indexer v3.8.2 and Later RAM Recommendations

For performance reasons, as much as possible of the MongoDB database should be held in RAM. The size of the MongoDB database is dependent on the number of data sources monitored by the Media Indexer. This section describes how to plan for loading all of the MongoDB database into RAM.

The number of data sources currently stored in the database is listed in the MI web interface on the Statistics tab as follows:

Statistics tab > MongoDB Information > FiDataSource Information > Items Count

This information combines the data source information for both MXF media files and AMA media files. The following illustration shows the Items Count value for a system monitoring 500000 data sources.

<table>
<thead>
<tr>
<th>MongoDB Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status: Available</td>
</tr>
<tr>
<td>Version: 3.2.4</td>
</tr>
<tr>
<td>Address: perfest-MI03:27017</td>
</tr>
<tr>
<td>Database Name: indexer</td>
</tr>
<tr>
<td>Collections: 4</td>
</tr>
<tr>
<td>Items Count: 500005</td>
</tr>
<tr>
<td>Average Item Size (in KB): 7</td>
</tr>
<tr>
<td>Data Size (in KB): 3562546</td>
</tr>
<tr>
<td>Storage Size (in KB): 743540</td>
</tr>
<tr>
<td>Indexes: 18</td>
</tr>
<tr>
<td>Index Size (in KB): 132084</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>FiDataSource Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Collection Name: FiDataSource</td>
</tr>
<tr>
<td>Schema Version: 1.0.3</td>
</tr>
<tr>
<td>Items Count: 5000000</td>
</tr>
<tr>
<td>Storage Size (in KB): 743484</td>
</tr>
<tr>
<td>Indexes: 10</td>
</tr>
<tr>
<td>Index Size (in KB): 131880</td>
</tr>
</tbody>
</table>

Determining the Amount of RAM for Media Indexer v3.8.2 and Later

You can calculate the amount of RAM required by multiplying the average amount of space that a data source occupies in the database times the number of data sources. On average, the average size is 10 KB, typically between 9 and 11 KB. The actual size depends on factors such as the custom attributes persisted in media files and the complexity of format descriptors. Both may increase in size depending on workflow and media creation.
These calculations take into account the fact that starting at Media Indexer v3.8.x, when the Media Indexer service starts up on a Media Indexer server, it automatically allocates RAM as follows:

- 40% RAM to MongoDB
- 40% RAM to the AvidMI.exe process
- The remainder is available to the operating system

There is a one-to-one correspondence between OpAtom mxf media files and data sources. If your site uses only OpAtom mxf media files you can use the following calculations directly. If the site also uses AMA media files, see “Calculations for AMA Media” on page 28.

For 1 million data sources, the calculation is as follows:

\[ 1 \text{ million} \times 10 \text{ KB} = 10 \text{ GB} \]
\[ 10 \text{ GB} = 40\% \text{ of (total RAM needed)} \]
\[ \text{Total RAM needed} = \frac{10}{.4} = 25 \text{ GB} \]

That is why the table lists 32 GB as a recommended (rounded up) amount of RAM for 1 million data sources.

For 2.5 million the calculation is as follows:

\[ 2.5 \text{ million} \times 10 \text{ KB} = 25 \text{ GB} \]
\[ 25 \text{ GB} = 40\% \times \text{(total RAM needed)} \]
\[ \text{Total RAM needed} = \frac{62}{1} = 62 \text{ GB} \]

So 64 GB is enough RAM for 2.5 million data sources as shown in the table.

When you get closer to 5 million data sources the amount increases - up to 120 GB for 5 million data sources.

You can also use the Media Indexer vmoptions to fine tune or customize the amount of RAM that the MongoDB database and AvidMI.exe process use. Testing has shown that 28GB is enough RAM for the AvidMI.exe process for a 5 million data source configuration.

Using vmoptions you can limit the amount of RAM as follows for 5 million data sources:

- 50 GB for the mongo database
- 28 GB for the MI process
- 8 GB for the remaining system
- Total = 86 GB

You can edit the MI vmoptions file to set these limits to fixed values. Note that when the values are fixed in the vmoptions file, the Media Indexer will not auto-adjust to the amount of available RAM.

**Editing the Media Indexer vmoptions File**

Use the following procedure to modify the Media Indexer vmoptions file for a Media Indexer server. This example sets the following RAM allocations:

- MI process memory = 28GB
- MongoDB memory = 50GB
This example assumes that 86GB is allocated to the Media Indexer server VM. After the MI process and MongoDB allocations are made, the remaining 8GB will be available to the server OS.

**To edit the AvidMI.vmoptions file:**

1. On the Media Indexer server, navigate to the following folder:
   
   `C:\Program Files\Avid\AvidMI\bin`

2. Open the following file in Notepad:
   
   `AvidMI.vmoptions`

3. Locate the following line in the file and ensure that it is set to YES:
   
   `adaptmemory=YES`

4. Locate the section that starts with the following lines:
   
   `;profile will be used in case when no Media Composer or Interplay Engine is present
   [standalone-memory-profile]`

5. Note that a semicolon identifies a comment.

6. Comment out the lines that set the memory factors to 0.4 and add lines that set the RAM for the MongoDB database and the MI process as follows:

   `;profile will be used in case when no Media Composer or Interplay Engine is present
   [standalone-memory-profile]
   ;mi-memory-factor=0.4
   ;mongo-memory-factor=0.4
   mi-memory-factor=0
   mi-memory-value=28g
   mongo-memory-factor=0
   mongo-memory-value=50g
   [java]
jrepath=..\jre`

7. Save and close the file.

8. Restart the Windows Service “Avid Interplay Media Indexer.” This will restart both the Media Indexer service and the MongoDB service.
   
   Note that when the `mi-memory-values` are fixed in the `vmoptions` file, the Media Indexer will not auto-adjust to the amount of available RAM.

**Calculations for AMA Media**

When providing an estimate of how many data sources will be added to a site over time, the results are different for OpAtom mxf media files and AMA media files.

- OpAtom mxf media files have a one-to-one correspondence with the data source count. So, adding 1000 OpAtom mxf media files over time is the same as adding 1000 data sources.

- Each AMA media file is represented in the MongoDB database by multiple data sources. One data source for each audio and video track. For example, if the average AMA clip contains 1 video track and 8 audio tracks, then each time you add an AMA media file you are adding 9 data sources. Adding 1000 AMA media files in this case adds 9000 data sources. This will increase the RAM requirements compared to adding only OpAtom mxf media files.
The Items Count value in the MI web interface described earlier shows the current combined data sources for both OpAtom mxf and AMA data sources. You can use that to calculate how much RAM you currently need. When you estimate the future total number of data sources for a site using AMA material you need to include the average number of audio and video tracks as part of the AMA portion of the calculation.

**MPI VM Recommendations**

Many of the recommendations for virtualized Interplay Production systems remain applicable to VMs hosting MAM / PAM Integration (MPI) services. This section highlights any variations between the Interplay Production and MPI virtual machines.

The following table lists recommend vCPUs based on the number of datasources (files) monitored by the Media Indexer.

**Working with vCPUs and RAM**

The following table lists recommendations for running multiple applications on a single VM. For additional information on adding vCPUs and RAM, see “Managing Virtual Resources” on page 18. For optimum performance of your VMs, contact your Avid representative.

**Multiple Applications per VM**

Applications can be grouped differently depending on the workflow at the site and the amount of load placed on individual applications. Consult your Avid representative for workflow related issues. For additional information on allocating vCPU resources, see “Managing and Monitoring VM Resources” on page 30.

<table>
<thead>
<tr>
<th>Applications Running on Single VM</th>
<th>vCPUs</th>
<th>Memory</th>
<th>Network Interface</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>MPI Dispatcher and PAM Adapter</td>
<td>4 vCPUs</td>
<td>8 GB RAM</td>
<td>VMXNET 3</td>
<td>a</td>
</tr>
<tr>
<td>MPI Worker (one or more)</td>
<td>4 vCPUs</td>
<td>16 GB RAM</td>
<td>VMXNET 3</td>
<td>See “Configuring Multiple Workers on a Single VM” on page 29 for additional details.</td>
</tr>
</tbody>
</table>

a. Hardware-based configurations require a 1 Gb network adapter for the Dispatcher and 10 Gb adapters for Worker machines. VMXNET 3 adapters are capable of scaling to 1Gb, 10 Gb, and higher depending on the available bandwidth of the network infrastructure.

**Configuring Multiple Workers on a Single VM**

MPI Workers are designed as multi-threaded applications which allows multiple Workers to operate efficiently on a single system. However, while multiple Workers can be installed, there is an eventual performance trade-off between total workers on a single machine and media re-wrapping time. Use the following table as a guideline to determine how many Workers should be installed on a single VM to best accommodate your workflow.
Managing and Monitoring VM Resources

As part of Avid’s best practices for running Interplay Production on VMs, enable the following Alarm Definitions from within vCenter Server:

- Virtual machine CPU usage
- Virtual machine memory usage
- Host CPU usage
- Host memory usage

The trigger parameters should be left at the default settings. Enable email notification and provide a monitored email address for these alarms.

Be aware that there will be instances where an alarm will be tripped for one of the virtual machine items that won’t require any action being taken.

For example, while running a VM with four Transcode Services installed (at a ratio of 1 transcode service per 2 vCPUs) and running, alerts were generated that the VM was experiencing high CPU usage. At first in excess of 75%, a ‘yellow’ alert status. Then in excess of 95%, a ‘red’ alert status. Upon investigation it was determined that the OS within the VM was also showing high CPU usage (ranged from around 80% to around 95%). The VM was consuming physical cores equal to half of what the host server had inside it. In essence, the VM was actually consuming more than half the GHz that the host listed as the total available. Capacity of the validation environment hosts was 41.58 GHz (16 2.6 GHz cores – ESXi overhead). The VM used a maximum of 22 GHz.

During this time, however, transcoding performance was not impacted. Time to transcode was actually better than if only one, or two, transcoding services were running on the same VM. Even though the VM was using less host resources during this time. It was during these tests that the ratio of 1 transcoding service per 2 vCPUs was determined.
If transcode performance had been degraded during the high CPU usage time frame, then it would have been reasonable to increase the vCPU allocation. But, since it was not, increasing the vCPU allocation would have resulted in degrading the performance of the VM (opposite of the desired affect).

Transcode performance can depend on source and target resolutions. For more information, contact your Avid Sales Representative.

**Monitoring vCPU Usage at Large Sites**

For large sites, monitor the VM’s CPU consumption levels at both the host (or vCenter) level as well as within the VM itself. IF vCenter reports high CPU usage (over 95%) for extended periods, and the CPU usage inside the VM (VM OS level) also report very high usage (over 98%), and there is a performance degradation, increase the amount of vCPUs allocated to the VM. All vCPU increases should be in small increments (no more than 2 at a time). After adding the CPU resources, monitor the VMs performance to determine if additional resources are required. Also keep close watch on CPU Ready metrics. An increase there will degrade the performance of the VM. This means the vCPU allocation is too high and should be reduced.

The use of (host and VM) monitoring solutions can be leveraged to help determine if additional resources need to be allocated, or if resources should be reduced. One such solution is provided by VMware under the vRealize product set.

**VMware Networking Best Practices**

For an overview of networking in a VMware environment, see the *vSphere Networking* guide at the following location:


**Best Practices for Working with Snapshots**

VMware snapshots are not backups. A snapshot file is only a change log of the original virtual disk. Do not rely on it as a direct backup process. Every bit change is recorded from the point where the snapshot is taken. The size (MB/GB) of the snapshot will continue to grow the longer it remains.

The virtual machine is running on the most current snapshot, not the original virtual machine disk (VMDK) files.

After creating a snapshot, the VM must read all information from the original image, plus the information in the change log. This inherently introduces performance degradation. Performance is further impacted if additional snapshots are created of the same VM. For this reason, it is best to avoid using snapshots with Avid virtual machines.

VMware recommends only a maximum of 32 snapshots in a chain. However, for better performance, use only 2 to 3 snapshots.

⚠️ **Do not use a single snapshot for more than 24-72 hours.**

For additional information on working with snapshots, see “Best Practices for virtual machines snapshots in the VMware Environment” on the VMware Knowledge Base:
http://kb.vmware.com/selfservice/microsites/microsite.do

Search for article ID 1025279.
This section describes how to create a VM (virtual machine) that is optimized for Interplay Production software. You can create a VM using either the thick (traditional) VMware client or using the VMware Web Client. This chapter describes how to create a VM with a VMware Web Client.

- Creating a New VM with the Web Client
- Powering on the VM for the First Time
- Creating a Template
- Creating a Customization Specification

Creating a New VM with the Web Client

Creating a new VM with the Web Client is slightly different from creating one with the thick client. The Web Client gives you the same choices as the “Custom” option in the thick client.

To create a new VM with the Web Client:

1. Open a web browser and log into the vSphere Web Client.
   - The web client can be accessed by navigating to: https://<vSphere server IP address or hostname>/vsphere-client.
2. Select the “Hosts and Clusters” option on the left side of the interface.
3. Click the arrows on the left to expand the tree and explore your vSphere environment.
4. Once you have selected a location for your new VM, right click on the tree and select “New Virtual Machine” as shown in the following illustration.
The New Virtual Machine wizard opens.

5. On page 1a, select the “Create a new virtual machine” option. Then click Next at the bottom of the page.

6. On page 2a, give the VM a name and select a folder for it to be listed under. Then click Next.
7. On page 2b, select the compute resource the VM will reside under. This can be either a host, a cluster, or a resource pool. Then click Next.

8. On page 2c, select where the VMs files will reside (datastore). Then click Next.
Creating a New VM with the Web Client

Depending on how your datastore is configured, you could have multiple options such as a storage cluster composed of multiple datastores presented from a SAN, or a single datastore that’s either on a SAN or local to the host.

If you have different tiers (or performance levels) of datastores, be sure to select the appropriate option for your configuration. Storage tier examples could include a set of large, but slower spinning disks or a set of fast but smaller solid state devices. Depending upon your configuration, VMs can be migrated to a different datastore later with Storage vMotion, a licensed option included in vSphere Standard Edition and higher.

9. On page 2d, select the compatibility option as “ESXi 6.0 and later.” Then click Next.

10. On page 2e, select the Guest OS Family and Version from the options available. Select “Windows” and “Microsoft Windows Server 2012 (64-bit).” Use this selection for Windows Server 2012 R2. Then click Next.

*The ESXi host servers (and vCenter Server) are already at version 6. Otherwise, this option would not be present. Even if the vCenter Server is at version 6, if the host is not, the highest compatibility option available will match the host version.*

*It is critical to correctly set the Guest OS Family and Version at this time. This influences what packages are installed for the VMware Tools. Incorrectly setting these parameters can cause issues including performance degradation and stability issues.*
The next group of settings (steps 9 through 16) apply to customizing the VM hardware.
11. On page 2f, expand the CPU listing and do the following:
   a. Set the CPU count to 2.
   b. Set the “Cores per Socket” count to 2.
   c. Select “Enable CPU Hot Add.”
      As a reminder, if your vCPU count exceeds the total core-count of one of the host server
      sockets, do not enable this feature.
   d. Select “Hardware virtualization: Expose hardware assisted virtualization to the guest OS.”
      If you have Enhanced vMotion Compatibility (EVC) mode enabled or plan to enable this
      feature in the future, do not select this setting.

   ![In the wizard, “CPU” refers to the vCPU.]

   ![Notice that when a menu item is altered, the color of the menu option changes from blue-gray to yellow and an asterisk (*) appears to the left of the menu option.]
12. Expand the “Memory” listing and do the following:
   a. Set the memory amount to what has been listed for the VM you are building.
   b. Check the Enable box for Memory Hot Plug.

   **The MB / GB menu defaults to MB (megabyte). Make sure to adjust this to GB (gigabyte).**

13. Expand the “New Hard disk” listing and do the following:
   a. Change the size to 80GB (this is the C drive).
   b. Change the Disk Provisioning to “Thick Provision Eager Zeroed.”

After you select Datastore ISO File, a dialog box opens. Select the ISO file to use. Then click OK.

It is common is to have OS install images (ISO files) on a datastore that the host can see and use. This is an option that allows for faster installs since the CD/DVD performs at storage speeds (the same or similar to the virtual drive speeds).
15. Expand the “New Network” listing and do the following:
   a. Select the port group where the VMs will get their network connections.
   b. Check the “Connect At Power On” box.
   c. Select “VMXNET 3” for the Adapter Type.

16. Delete the New Floppy Drive listing by clicking the x on the right of the page.

17. Click the VM Options tab.

18. Expand the “Boot Options” item and check the “Force BIOS setup” box. Then click Next.
### Creating a New VM with the Web Client

#### Customizing Hardware
Configure the virtual machine hardware.

<table>
<thead>
<tr>
<th>Virtual Hardware</th>
<th>VM Options</th>
<th>SDRS Rules</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Customize hardware</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>General Options</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>VMware Remote Console Options</td>
<td></td>
<td></td>
</tr>
<tr>
<td>VMware Tools</td>
<td>Expand for VMware Tools settings</td>
<td></td>
</tr>
<tr>
<td>Power management</td>
<td>Expand for power management settings</td>
<td></td>
</tr>
<tr>
<td><strong>Boot Options</strong></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Firmware</th>
<th>Choose which firmware should be used to boot the virtual machine</th>
</tr>
</thead>
<tbody>
<tr>
<td>Boot Delay</td>
<td>Whenever the virtual machine is powered on or reset, delay the boot for</td>
</tr>
<tr>
<td>Force BIOS setup (*)</td>
<td>The next time the virtual machine boots, force entry into the BIOS</td>
</tr>
<tr>
<td>Failed Boot Recovery</td>
<td>When the virtual machine fails to find a boot device, automatically retry</td>
</tr>
<tr>
<td>Advanced</td>
<td>Expand for advanced settings</td>
</tr>
<tr>
<td>Fibre Channel NPIV</td>
<td>Expand for Fibre Channel NPIV settings</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>New Virtual Machine</th>
<th>Provisioning type:</th>
<th>Create a new virtual machine</th>
</tr>
</thead>
<tbody>
<tr>
<td>Virtual machine name:</td>
<td>webclientVM1</td>
<td></td>
</tr>
<tr>
<td>Folder:</td>
<td>BSI_3.3_VMs</td>
<td></td>
</tr>
<tr>
<td>Resource pool:</td>
<td>BSI_3.3_VMs</td>
<td></td>
</tr>
<tr>
<td>Datastore:</td>
<td>Storage_Cluster1 [VMware03] (Recommended)</td>
<td></td>
</tr>
<tr>
<td>Guest OS name:</td>
<td>Microsoft Windows Server 2012 (64-bit)</td>
<td></td>
</tr>
<tr>
<td>CPUs:</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>Memory:</td>
<td>12 GB</td>
<td></td>
</tr>
<tr>
<td>NICs:</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>NIC 1 network:</td>
<td>VM Net acsvirt 160 (dvSwitch)</td>
<td></td>
</tr>
<tr>
<td>NIC 1 type:</td>
<td>VMXNET3</td>
<td></td>
</tr>
<tr>
<td>SCSI controller 1:</td>
<td>LSI Logic SAS</td>
<td></td>
</tr>
<tr>
<td>Create hard disk 1:</td>
<td>New virtual disk</td>
<td></td>
</tr>
<tr>
<td>Capacity:</td>
<td>80.00 GB</td>
<td></td>
</tr>
<tr>
<td>Datastore:</td>
<td>Storage_Cluster1 [VMware03] (Recommended)</td>
<td></td>
</tr>
<tr>
<td>Virtual device node:</td>
<td>LSI(0:0)</td>
<td></td>
</tr>
<tr>
<td>Mode:</td>
<td>Dependent</td>
<td></td>
</tr>
</tbody>
</table>

In this example, only one hard disk is specified. The secondary (or D) drive on the VM is not specified. If you are creating a template, this is not necessary. You can add a drive during or after deployment of the template. If you want to add the secondary drive, complete the following steps.

*It is common to build a VM for a template that specifies a smaller C drive, and no D drive. The C drive needs to be large enough to handle the OS being installed (Windows) without having any issues, such as 40GB for Windows Server 2012 R2. During deployment, you can increase the size of the C drive and then expand it to fill when the VM is ready for use.*

20. Do one of the following:
   - Click the Back button to return to that category.
   - Select the “2f Customize hardware” line to the left to get back to that category
Creating a New VM with the Web Client

The “New Hard disk” listing is added to the bottom of the virtual hardware list, as shown in the following illustration.

22. Change the size to match the requirements and set the “Disk Provisioning” according to the VM being created.
23. Review all the settings again.

24. If everything is correct, click the Finish button and the VM is created.

25. Continue to the next section, “Powering on the VM for the First Time” on page 47
Powering on the VM for the First Time

After powering on the VM, you need to change some settings in the BIOS. Then install the operating system and the VMware tools.

**To power on the VM, set up the BIOS, install the operating system, and install the VMware tools:**

1. In the Device Status section of the vSphere Web Client, do one of the following:
   - If the VM is not powered on, ensure that the check box for “Connect at power on” is checked.
   - If the VM is powered on, select the “Connected” check box.
2. Power on the VM and make the BIOS setting changes shown in the following illustration.

![PhoenixBIOS Setup Utility](image)

3. Remove the floppy drive (Legacy Diskette) from BIOS. Even though it has been removed in the virtual hardware, it needs to be removed from the VM’s BIOS as well. Use the space bar to cycle through the options until the Legacy Diskette A is listed as Disabled.
4. Select the Boot tab and set the virtual BIOS boot order for the VM as shown in the following illustration.

5. When done altering the BIOS settings, use the Exit menu or press F10 to “Save and Exit.”

   The VM automatically reboots.

6. Complete the operating system installation.

7. Install VMware tools. See the VMware documentation for details.
Creating a Template

After creating the VM, changing BIOS settings, and installing the OS, you can create a template. Creating a template saves you much time and effort. Depending on the performance/specification of your SAN, deploying a new VM from template can take 5-10 minutes (from initiating the creation, to having a VM ready for additional installs). This includes having the VM bound to a domain, given a new IP address (static or via DHCP), and the name changed (typical is having the localhost/DNS name match the VM name).

For example, you should use a template if you are going to create a Microsoft cluster for the Interplay Engine, as described in “Creating an Interplay Engine Failover Cluster Using VMware Hosts” on page 54.

The ability to create a template is only available with vCenter and licensed VMware host servers (ESXi). This feature is available even with the 'Standard Edition' license.

To convert a VM to a template:
1. Log in to the vSphere Web Client.
2. Right-click the VM you have created and select Template > Convert to Template.
   In the following illustration, the VM resides in the Templates folder.

3. At the end of the process, the VM is converted to a template.
Creating a Customization Specification

When you deploy a virtual machine from a template, you can use a customization specification to set properties such as the computer name, network settings, and license settings. You create a customization specification by using the Guest Customization wizard. The following procedure lists important settings for Avid VMs when you run the wizard. For more information, see the VMware documentation.

To create a customization specification:
1. From the vSphere Client Home page, select Customization Specifications Manager.
2. Click the “Create a new specification” button to open the New VM Guest Customization Spec wizard.
   The following illustration shows the opening page.
   ![Opening Page](image)
3. Proceed through the wizard, entering information based on your environment. In particular, make sure you specify the following settings:
   a. On page 3, “Set Computer Name,” select “Use the virtual machine name.”

   ![Set Computer Name](image)
b. On page 5, “Set Administrator Password,” enter the administrator password for the virtual machine. Select “Automatically logon as Administrator” and select the number of times you want to log on automatically. This number depends on your environment.

![Set Administrator Password](image_url)

On page 8, “Configure Network,” select “Manually select custom settings.”

![Configure Network](image_url)

Click the Edit button for the NIC and supply the network information for your environment.
- For IPv4, select “Prompt the user for an address when the specification is used” and supply the other IP settings.

Also supply settings for DNS and WINS.

d. On page 9, “Set Workgroup or Domain,” select the appropriate option for this customization specification. For computers that need to be bound to the domain (such as VMs that are used to build a Microsoft failover cluster), select Windows Server Domain and enter the domain name. Add a user account that has permission to add a computer to the domain.
4. On page 11, review your settings. Click Finish to save your changes.

The customization specification that you created will be listed in the Customization Specification Manager.
The Interplay Engine can be installed and configured as a failover cluster through the Microsoft Failover Clustering feature in Windows Server 2012 R2. The following topics provide information for creating an Interplay Engine failover cluster that runs on VMware hosts:

- Overview of Creating a Virtualized Interplay | Engine Failover Cluster
- Create the VM Nodes
- Add Shared Storage Volumes to the First Node
- Add Shared Storage Volumes to the Second Node
- Install and Configure the Microsoft Cluster Service
- Installing the Interplay Engine
- After Installing the Interplay | Engine
- Create an Interplay | Production Database
- Test the Complete Installation
- Install a Permanent License
- Configure the Cluster for a vSphere HA and vSphere DRS Environment

Much of the information in this chapter is adapted from *Setup for Failover Clustering and Microsoft Cluster Service*, published by VMware and available here:


**Overview of Creating a Virtualized Interplay | Engine Failover Cluster**

An Interplay Engine failover cluster for two physical servers and a shared-storage array has been supported since early releases of Interplay Production. Starting with Interplay Production v3.5, an Interplay Engine cluster is supported on virtual machines configured and managed through VMware software.

The *Interplay | Engine Failover Guide for Windows Server 2012* describes failover cluster technology, how to prepare for and install a Microsoft cluster, and how to install the Interplay Engine software. Parts of this guide contain information that applies to creating a virtualized Interplay Engine failover cluster and are referred to in this chapter. This guide is available on the Avid Knowledge Base:

This chapter provides information that is specific to creating a virtualized Interplay Engine failover cluster. Several VMware configurations are possible. Avid recommends a configuration consisting of two virtual machines on two different physical machines (ESXi hosts), as described in “Clustering Virtual Machines Across Physical (ESXi) Hosts” on page 55.

To help you create the failover cluster, use the check list in “Check List for Creating an Interplay | Engine Failover Cluster on VMware Hosts” on page 56.

**Clustering Virtual Machines Across Physical (ESXi) Hosts**

A cluster of virtual machines across physical hosts (also known as a “cluster across boxes”) protects against software failures and hardware failures on the physical machine by placing the cluster nodes on separate ESXi hosts. This configuration requires a shared-storage SAN for the quorum and database volumes.

The following figure shows a cluster-across-boxes setup, with two physical ESXi hosts and one SAN (Storage Area Network). This configuration uses the SAN to host the following:

- Two virtual machines running clustering software.
- A private network connection for the private heartbeat and a public network connection.
- A quorum volume and a database volume.
# Check List for Creating an Interplay | Engine Failover Cluster on VMware Hosts

Use the following check list to help you create the Interplay Engine failover cluster.

<table>
<thead>
<tr>
<th>Task</th>
<th>Section Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Determine the networking requirements, hostnames, and IP addresses for the cluster.</td>
<td>“Preflight Checklist” on page 57</td>
</tr>
<tr>
<td>Create two VMs in your VMware host cluster on shared-storage (SAN).</td>
<td>“Create the VM Nodes” on page 60</td>
</tr>
<tr>
<td>Create the nodes for the cluster.</td>
<td>“Create the VM Nodes” on page 60</td>
</tr>
<tr>
<td>Configure the network adapters.</td>
<td>“Configure the Public and Private Network Adapters” on page 64</td>
</tr>
<tr>
<td>Add the drive to the clusters.</td>
<td>“Add Shared Storage Volumes to the First Node” on page 73 and “Add Shared Storage Volumes to the Second Node” on page 74</td>
</tr>
<tr>
<td>Create the cluster</td>
<td>“Install and Configure the Microsoft Cluster Service” on page 74</td>
</tr>
<tr>
<td>Install the Interplay Engine</td>
<td>“Installing the Interplay Engine” on page 91</td>
</tr>
<tr>
<td>Perform post-installation tasks.</td>
<td>“Bring the Interplay</td>
</tr>
<tr>
<td></td>
<td>“Create an Interplay</td>
</tr>
<tr>
<td></td>
<td>“Test the Complete Installation” on page 104</td>
</tr>
<tr>
<td></td>
<td>“Install a Permanent License” on page 105</td>
</tr>
<tr>
<td>Configure the hosts and virtual machines for a vSphere High Availability (vSphere HA) or vSphere Distributed Resource Scheduler (DRS) environment</td>
<td>“Configure the Cluster for a vSphere HA and vSphere DRS Environment” on page 105</td>
</tr>
</tbody>
</table>
Preflight Checklist

Before you begin to create the cluster, make sure you have the following tasks completed:

- Domain controller is available for the cluster nodes to join.
- DNS forward and reverse zones are created.
- All required hostnames are determined.
- Network TCP/IP properties for all hosts and virtual names are determined.

Use the following checklist to record the hostnames and TCP/IP properties. See “Requirements for Domain User Accounts” on page 58.

### Preflight Checklist

<table>
<thead>
<tr>
<th>Value</th>
<th>Node 1</th>
<th>Node 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hostname</td>
<td>-IE01</td>
<td>-IE02</td>
</tr>
<tr>
<td>Domain Name</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Public Network Address</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Subnet Mask</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Default Gateway</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Primary DNS</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Secondary DNS (optional)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Private Network Address</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Subnet Mask</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Default Gateway</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Primary DNS</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Secondary DNS (optional)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>IP Engine Virtual Name</td>
<td></td>
<td>-IEV</td>
</tr>
<tr>
<td>IP Engine Virtual IP Address</td>
<td></td>
<td>-MIEC</td>
</tr>
<tr>
<td>Cluster Name</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cluster IP Address</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Recommended Naming Conventions**

- `SitePrefix-IE01` = Interplay Engine 01
- `SitePrefix-IE02` = Interplay Engine 02
- `SitePrefix-IEV` = Interplay Engine Virtual Name
- `SitePrefix-MIEC` = Microsoft Interplay Engine Cluster Name
Requirements for Domain User Accounts

Before beginning the cluster installation process, you need to select or create the following user accounts in the domain that includes the cluster:

- **Server Execution User**: Create or select an account that is used by the Interplay Engine services (listed as the Avid Workgroup Engine Monitor and the Avid Workgroup TCP COM Bridge in the list of Windows services). This account must be a domain user. This account is automatically added to the Local Administrators group on each node by the Interplay Engine software during the installation process.

  The Server Execution User is not used to start the Cluster service for a Windows Server 2012 installation. Windows Server 2012 uses the OS login account to start the Cluster service. The Server Execution User is used to start the Avid Workgroup Engine Monitor and the Avid Workgroup TCP COM Bridge.

  The Server Execution User is critical to the operation of the Interplay Engine. If necessary, you can change the name of the Server Execution User after the installation. For more information, see “Troubleshooting the Server Execution User Account” and “Re-creating the Server Execution User” in the Interplay | Engine and Interplay | Archive Engine Administration Guide and the Interplay Help.

- **Cluster installation account**: Create or select a domain user account to use during the installation and configuration process. There are special requirements for the account that you use for the Microsoft cluster installation and creation process (described below).

  - If your site allows you to use an account with the required privileges, you can use this account throughout the entire installation and configuration process.
  
  - If your site does not allow you to use an account with the required privileges, you can work with the site’s IT department to use a local Administrator’s account only for the Microsoft cluster creation steps. For other tasks, you can use a domain user account without the required privileges.

In addition, the cluster installation account must have administrative permissions on the servers that will become cluster nodes. You can do this by adding the account to the local Administrators group on each of the servers that will become cluster nodes.

**Requirements for Microsoft cluster creation**: To create a user with the necessary rights for Microsoft cluster creation, you need to work with the site’s IT department to access Active Directory (AD). Depending on the account policies of the site, you can grant the necessary rights for this user in one of the following ways:

- Create computer objects for the failover cluster (virtual host name) and the Interplay Engine (virtual host name) in the Active Directory (AD) and grant the user Full Control on them. In addition, the failover cluster object needs Full Control over the Interplay Engine object. For examples, see “Preflight Checklist” on page 57.

  The account for these objects must be disabled so that when the Create Cluster wizard and the Interplay Engine installer are run, they can confirm that the account to be used for the cluster is not currently in use by an existing computer or cluster in the domain. The cluster creation process then enables the entry in the AD.

- Make the user a member of the Domain Administrators group. There are fewer manual steps required when using this type of account.
- Grant the user the permissions “Create Computer objects” and “Read All Properties” in the container in which new computer objects get created, such as the computer’s Organizational Unit (OU).


Roaming profiles are not supported in an Interplay Production environment.

- **Cluster administration account**: Create or select a user account for logging in to and administering the failover cluster server. Depending on the account policies of your site, this account could be the same as the cluster installation account, or it can be a different domain user account with administrative permissions on the servers that will become cluster nodes.
Create the VM Nodes

Avid recommends using VMware templates to deploy new Windows Server 2012 R2 VMs. During the deploy process, check your settings, as described in the following procedure.

⚠️ During the deployment, make sure to select Thick Provision Eager Zeroed on the “Select storage” page.

Prerequisite

Before deploying, make sure you have an existing customization specification or create one. For more information, see “Creating a Customization Specification” on page 50.

To create the VM nodes:

1. Open the vSphere Web Client and log in to the vCenter Server.
2. In the vSphere Web Client navigator, click the VM and Templates view.
3. Right-click an existing VM template and select New VM from This Template.

The following illustration shows a template in the Templates folder selected and ready to be deployed.
The first page of the Deploy from Template wizard is displayed.

4. Proceed through the wizard, checking your settings. In particular, review the following:
b. On page 1d, “Select clone options,” review the following:
   - Select “Customize the operating system.”
   - Select “Customize this virtual machine’s hardware (Experimental)”
   - (Optional) Select “Power on virtual machine after creation.” This starts the VM immediately after you create it in the last step of this deployment.

c. On page 1e, “Customize guest OS,” select your customization specification.
d. On page 1f, “Customize hardware,” review the following:
- CPU listing: Select either 2 or 4 CPU initially, depending on workload.
- CPU listing (expanded): Select “Enable CPU Hot Add.”
- Memory listing: Select the RAM size according to the database size.
- Memory listing (expanded): Enable “Memory Hot Plug.”
- Network adapter 1 listing: Make sure the correct port group is connected.
Configure the Public and Private Network Adapters

5. On page 2, “Ready to complete,” review your selections, then click Finish to complete creating the virtual machine.

6. Click Finish.

   The vCenter server starts provisioning the VM. After the provisioning is complete, add the private network as described in the next step.

7. Right-click the VM you just created and select Edit Settings.

8. In the Edit Settings dialog box, do the following:
   a. From the “New device” drop-down menu, select Network. Then click Add.
   b. Select the Port Group that is used for the private network (cluster heartbeat) connection.
   c. Select VMXNET3 for the Adapter Type.
   d. Click OK.

9. Repeat this procedure to create the second node.

Do not add shared cluster disks at this time.

Configure the Public and Private Network Adapters

You configure two virtual network adapters to handle the virtual machine traffic for the cluster:

- A private network connection (named “Private”) for the cluster heartbeat
- A public network connection (named “Public”) for all other network communication and traffic

For a cluster with virtual machines, both the private and public networks should have complete TCP/IP configurations with the following:

- IP Address
- Subnet Mask
- Default Gateway
- Primary DNS
- DNS Suffix
Configure the Public and Private Network Adapters

Rename the Network Adapters

You need to rename network adapters on each node to appropriately identify each network.

To rename the network adapters:
1. Log in to node 1.
2. Click Start > Control Panel > Network and Sharing Center.
   The Network and Sharing Center window opens.
3. Click “Change adapter settings” on the left side of the window.
4. Right-click a network adapter and select Rename.
5. Type Private for the network adapter and press Enter.
6. Right-click the other network adapter and select Rename.
7. Type Public for the network adapter and press Enter.

The following illustration shows the Network Connections window with the new names.

Configure the Public Network on Node 1

To configure the public network:
1. Log in to node 1, if necessary.
2. Click Start > Control Panel > Network and Sharing Center.
   The Network and Sharing Center window opens.
3. Click “Change adapter settings” on the left side of the window.
   The Network Connections window opens.
4. Right-click the Public network connection and select Properties.
   The Properties dialog box opens.
5. On the Networking tab do the following:
   a. Deselect Internet Protocol Version 6 (TCP/IPv6)
   b. Highlight Internet Protocol Version 4 (TCP/IPv4) and click Properties.
6. On the General tab of the Internet Protocol (TCP/IP) Properties dialog box, do the following:
   a. Select “Use the following IP address.”
   b. Enter the IP address assigned to the Public network connection for node 1.
   c. Enter the Subnet mask assigned to the Public network connection for node 1.
   d. Enter the Default gateway assigned to the Public network connection for node 1.
   e. Enter the Preferred DNS server assigned to the Public network connection for node 1.
7. Click Advanced.
   The Advanced TCP/IP Settings dialog box opens.

8. On the DNS tab, do the following:
   a. Select the option “Append these DNS suffixes (in order).”
   b. Click the Add button.
   c. Enter the DNS suffix for the Public network on node 1 and click Add.
   d. Enter the DNS suffix for the Public network on node 1 in the “DNS suffix for this connection” box.
   e. Select the options “Register this connection’s addresses in DNS” and “Use this connection’s DNS suffix in DNS registration.”
9. Click OK until you have exited from the TCP/IP Properties dialog box.
Configure the Private Network on Node 1

To configure the private network:

1. Return to the Network Connections window.
2. Click “Change adapter settings” on the left side of the window.
   The Network Connections window opens.
3. Right-click the Private network connection and select Properties.
   The Private Properties dialog box opens.

4. On the Networking tab do the following:
   a. Select Internet Protocol Version 4 (TCP/IPv4)
   b. Deselect all other items.
5. Highlight Internet Protocol Version 4 (TCP/IPv4) and click Properties.
6. On the General tab of the Internet Protocol (TCP/IP) Properties dialog box, do the following:
   a. Select “Use the following IP address.”
   b. Enter the IP address assigned to the Private network connection for node 1.
   c. Enter the Subnet mask assigned to the Private network connection for node 1.
   d. Enter the Default gateway assigned to the Private network connection for node 1.
   e. Enter the Preferred DNS server assigned to the Private network connection for node 1.
7. Click Advanced.
   The Advanced TCP/IP Settings dialog box opens.
8. On the DNS tab, do the following:
   a. Select the option to Append these DNS suffixes (in order).
   b. Click the Add button.
   c. Enter the DNS suffix for the Private network on node 1 and click Add.
   d. Enter the DNS suffix for the Private network on node 1 in the “DNS suffix for this connection” box.
   e. Select the option “Register this connection’s addresses in DNS” and “Use this connection’s DNS suffix in DNS registration.”
9. Click the WINS tab and do the following:

![Advanced TCP/IP Settings](image)

- a. Make sure no values are defined in the WINS addresses area.
- b. Make sure “Enable LMHOSTS lookup” is selected.
- c. Select “Disable NetBIOS over TCP/IP.”

10. Click OK.

A message might be displayed stating “This connection has an empty primary WINS address. Do you want to continue?” Click Yes.

11. Click OK until you have exited from the TCP/IP Properties dialog box.

**Configure the Binding Order for the Public and Private Network**

**To configure the binding order for the networks:**

1. On node 1, click Start > Control Panel > Network and Sharing Center.
   The Network and Sharing Center window opens.
2. Click “Change adapter settings” on the left side of the window.
   The Network Connections window opens.
3. Press the Alt key to display the menu bar.
4. Select the Advanced menu, then select Advanced Settings.
   The Advanced Settings dialog box opens.
5. In the Connections area, use the arrow controls to position the network connections in the following order:
   - Public
   - Private

6. Click OK.

**Configure the Private and Public Network on Node 2**

Repeat the TCP/IP configuration procedures you used for node 1 to configure node 2:

- “Rename the Network Adapters” on page 65
- “Configure the Public Network on Node 1” on page 65
- “Configure the Private Network on Node 1” on page 68
- “Configure the Binding Order for the Public and Private Network” on page 71
Verify Communication Between Node 1 and Node 2

To verify the connection between node 1 and node 2:

1. From node 1, ping the public address of node 2.
2. From node 1 ping the private address of node 2.
3. From node 2 ping the public address of node 1.
4. From node 2 ping the private address of node 1.

All pings should be successful and return the FQDN of the server.

Join Both Node 1 and Node 2 to the Correct Domain

After configuring the network information described in the previous topics, join the two servers to the Active Directory domain. Each server requires a reboot to complete this process. At the login window, use the local administrator account (see “Preflight Checklist” on page 57).

This can be done as part of the deploy from template task if the Customization Specification setting includes the relevant information.

Add Shared Storage Volumes to the First Node

You need to set up two shared storage volumes: a quorum disk for the cluster configuration database and a second disk for the Interplay Production database. Use the following information for the shared volumes:

<table>
<thead>
<tr>
<th>Volume</th>
<th>Name and Drive Letter</th>
<th>Size</th>
<th>SCSI ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disk 1</td>
<td>Quorum (Q:)</td>
<td>10 GB</td>
<td>SCSI Controller 1 (1:0)</td>
</tr>
<tr>
<td>Disk 2</td>
<td>Database (S:)</td>
<td>800 GB</td>
<td>SCSI Controller 1 (1:1)</td>
</tr>
</tbody>
</table>

To add shared volumes to the first node:

1. In the vSphere Web Client, select the VM used for node 1, right-click and select Edit Settings.
2. Click the “New device” drop-down menu, select SCSI Controller, and click Add.
3. Expand “New SCSI controller” and select Physical from the SCSI Bus Sharing drop-down menu.
4. Click OK. The Edit Settings dialog box closes.
5. In the vSphere Web Client, select Edit Settings again.
6. Click the “New device” drop-down menu, select RDM Disk, and click Add.
7. Expand “New Hard Disk” and select an unformatted LUN of 10 GB to use as the Quorum disk.
8. For Compatibility mode, select Physical.
10. For New Virtual Device, select SCSI Controller 1 (1:0) and click Next.
11. Click OK. The wizard creates the new hard disk.
12. Repeat this procedure to add the database disk (800 GB) and SCSI Controller 1 (1:1)
13. Use the Windows Disk Management tool to bring the disks online, initialize the disks, and format the disks as Quorum (Q:) and Database (S:).

When you initialize the disks, make sure to select MBR (Master Boot Record). Then use the New Simple Volume wizard to configure the disks as partitions. For more information, see the Interplay / Engine Failover Guide for Windows Server 2012 or the Windows documentation.

The virtual machine used as node 1 is now connected to a public network and a private network with two virtual switches, and is connected to the quorum disk and database disk on the SAN.

**Add Shared Storage Volumes to the Second Node**

To allow shared access to clustered services and data, point the quorum disk and database disks of the second node to the same location as the first node's disks.

**Prerequisites:**

Before you begin, make sure you have the following information:

- The location of the quorum disk and database disk specified for the first node.
- Which virtual device nodes are used for the disks. These should be SCSI Controller 1 (1:0) for the quorum disk and SCSI Controller 1 (1:1) for the database disk.

**To add shared volumes to the second node:**

1. In the vSphere Web Client, select the VM used for node 2, right-click and select Edit Settings.
2. Expand “New SCSI controller” and select “LSI Logic SAS” from the Change Type drop-down menu.
3. Select “Physical” from the SCSI Bus Sharing drop-down menu.
4. Click OK. The Edit Settings dialog box closes.
5. In the vSphere Web Client, select Edit Settings.
6. Click the “New device” drop-down menu, select Existing Hard Disk, and click Add.
7. In Disk File Path, browse to the location of the quorum disk specified for the first node.
8. For Compatibility mode, select Physical.
10. For New Virtual Device, select SCSI Controller 1 (1:0) and click Next.
11. Click OK. The wizard creates the new hard disk.
12. Repeat this procedure to add the database disk and SCSI Controller 1 (1:1)

**Install and Configure the Microsoft Cluster Service**

Take the following steps to configure the failover cluster:

1. Install the Failover Clustering feature. See “Install the Failover Clustering Features” on page 75.
2. Start the Create Cluster Wizard on the first node. See “Create the Failover Cluster” on page 80. This procedure creates the failover cluster for both nodes.
3. Rename the cluster networks. See “Renaming the Cluster Networks in the Failover Cluster Manager” on page 85.
4. Rename the Quorum disk. See “Rename the Quorum Disk” on page 87.
5. Remove other disks from the cluster. See “Remove Disks Other Than the Quorum Disk” on page 88
6. Test the failover. See “Test the Cluster Installation” on page 89.

Install the Failover Clustering Features

Windows Server 2012 requires you to add the following features:

- Failover Clustering (with Failover Cluster Management Tools and Failover Cluster Module for Windows PowerShell)
- Failover Cluster Command Interface

You need to install these on both servers.

To install the Failover Clustering features:

1. Open the Server Manager window (for example, right-click This PC and select Manage).
2. In the Server Manager window, select Local Server.
3. From the menu bar, select Manage > Add Roles and Features.
   The Add Roles and Features Wizard opens.
4. Click Next.
   The Installation Type screen is displayed.
5. Select “Role-based or feature-based installation” and click Next.
The Server Selection screen is displayed.

6. Make sure “Select a server from the server pool” is selected. Then select the server on which you are working and click Next.
The Server Roles screen is displayed. Two File and Storage Services are installed. No additional server roles are needed. Make sure that “Application Server” is not selected.

7. Click Next.

The Features screen is displayed.
8. Select Failover Clustering.
   The Failover Clustering dialog box is displayed.

9. Make sure “Include management tools (if applicable)” is selected, then click Add Features.
   The Features screen is displayed again.
10. Scroll down the list of Features, select Remote Server Administration Tools > Feature Administration Tools > Failover Clustering Tools, and select the following features:
   - Failover Cluster Management Tools
   - Failover Cluster Module for Windows PowerShell
   - Failover Cluster Command Interface

11. Click Next.
    The Confirmation screen is displayed.

12. Click Install.
    The installation program starts. At the end of the installation, a message states that the installation succeeded.
13. Click Close.
14. Repeat this procedure on the other cluster server node.

Create the Failover Cluster

To create the failover cluster:
1. On node 1, log in to the operating system using the cluster installation account (see “Preflight Checklist” on page 57).
2. Open Failover Cluster Manager. There are several ways to open this window. For example,
   a. On the desktop, right-click This Computer and select Manage.
      The Server Manager window opens.
   b. In the Server Manager list, click Tools and select Failover Cluster Manager.
      The Failover Cluster Manager window opens.
3. In the Management section, click Validate Configuration and follow the instructions to make sure the configuration is correct.
4. In the Management section, click Create Cluster.
   The Create Cluster Wizard opens with the Before You Begin window.
5. Review the information and click Next (you will validate the cluster in a later step).
6. In the Select Servers window, type the simple computer name of node 1 and click Add. Then type the computer name of node 2 and click Add. The Cluster Wizard checks the entries and, if the entries are valid, lists the fully qualified domain names in the list of servers, as shown in the following illustration:

![Select Servers Window](image)

If you cannot add the remote node to the cluster, and receive an error message “Failed to connect to the service manager on `<computer-name>`,” check the following:
- Make sure that the time settings for both nodes are in sync.
- Make sure that the login account is a domain account with the required privileges.
- Make sure the Remote Registry service is enabled.

7. Click Next.
   The Validation Warning window opens.

8. Select Yes and click Next several times. When you can select a testing option, select Run All Tests.
   The automatic cluster validation tests begin. The tests take approximately five minutes. After running these validation tests and receiving notification that the cluster is valid, you are eligible for technical support from Microsoft.
   The following tests display warnings, which you can ignore:
   - List Software Updates (Windows Update Service is not running)
   - Validate Storage Spaces Persistent Reservation
   - Validate All Drivers Signed
   - Validate Software Update Levels (Windows Update Service is not running)
9. In the Access Point for Administering the Cluster window, type a name for the cluster, then click in the Address text box and enter an IP address. This is the name you created in the DNS (see “Preflight Checklist” on page 57).

10. Click Next.

A message informs you that the system is validating settings. At the end of the process, the Confirmation window opens.
11. Review the information. Make sure “Add all eligible storage to the cluster” is selected. If all information is correct, click Next.

The Create Cluster Wizard creates the cluster. At the end of the process, a Summary window opens and displays information about the cluster.

You can click View Report to see a log of the entire cluster creation.

12. Click Finish.

Now when you open the Failover Cluster Manager, the cluster you created and information about its components are displayed, including the networks available to the cluster networks). To view the networks, select Networks in the list on the left side of the window.

The following illustration shows components of the cluster. Cluster Network 1 is a public network (Cluster and Client), and Cluster Network 2 is a private, internal network for the heartbeat (Cluster only).
Renaming the Cluster Networks in the Failover Cluster Manager

You can more easily manage the cluster by renaming the networks that are listed under the Failover Cluster Manager.

To rename the networks:
1. Right-click This PC and select Manage. The Server Manager window opens.
2. In the Failover Cluster Manager, select `cluster_name` > Networks.
3. In the Networks window, right-click Cluster Network 1 and select Properties.
   
The Properties dialog box opens.
4. Click in the Name text box, and type a meaningful name, for example, a name that matches the name you used in the TCP/IP properties. Use Public, as shown in the following illustration. For this network, keep the option “Allow clients to connect through this network.”
5. Click OK.
6. Rename Cluster Network 1 as Public. For this network, keep the option “Allow clients to connect through this network.” Click OK.

7. Rename the other network Private. This network is used for the heartbeat. For this private network, leave the option “Allow clients to connect through this network” unchecked. Click OK.

The following illustration shows the renamed networks.

![Cluster Network 2 Properties](image)

![Failover Cluster Manager](image)
**Rename the Quorum Disk**

You can more easily manage the cluster by renaming the disk that is used as the Quorum disk.

**To rename the Quorum disk:**

1. In the Failover Cluster Manager, select *cluster_name* > Storage > Disks.

   The Disks window opens. Check to make sure the smaller disk is labeled “Disk Witness in Quorum.” This disk most likely has the number 1 in the Disk Number column.

2. Right-click the disk assigned to “Disk Witness in Quorum” and select Properties.

   The Properties dialog box opens.
3. In the Name dialog box, type a name for the cluster disk. In this case, Cluster Disk 2 is the Quorum disk, so type Quorum as the name.

![Cluster Disk 2 Properties](image)

4. Click OK.

**Remove Disks Other Than the Quorum Disk**

You must delete any disks other than the Quorum disk. There is most likely only one other disk, which will be later be added by the Interplay Engine installer. In this operation, deleting the disk means removing it from cluster control. After the operation, the disk is labeled offline in the Disk Management tool. This operation does not delete any data on the disks.

**To remove all disks other than the Quorum disk:**

1. In the Failover Cluster Manager, select `cluster_name` > Storage and right-click any disks not used as the Quorum disk (most likely only Cluster Disk1).
2. In the Actions panel on the right, select Remove.

A confirmation box asks if you want the remove the selected disks.

3. Click Yes.

**Test the Cluster Installation**

At this point, test the cluster installation to make sure the failover process is working.

**To test the failover:**

1. Make sure both nodes are running.
2. Determine which node is the active node (the node that owns the quorum disk). Open the Failover Cluster Manager and select `cluster_name > Storage > Disks`. The server that owns the Quorum disk is the active node.
   
   In the following figure, the Owner Node is muc-vtldell1.

3. In the left pane select your cluster name.
4. Confirm that node 1 is currently shown as the Owner Node.
5. Right-click the Avid Workgroup server and select Move > Select Node.
The Move Clustered Role dialog window opens. (Node names in the following example are different from the node names in the rest of the procedure.)

6. Select node 2 and click OK.

7. Open the Failover Cluster Manager and select `cluster_name` > Storage > Disks. Make sure that the Quorum disk is online and that current owner is node 2, as shown in the following illustration.
8. In the Failover Cluster Manager, select `cluster_name` > Networks. The status of all networks should be “Up.”

The following illustration shows the networks.

9. Repeat the test to move the cluster back to node 1.

Configuration of the failover cluster on all nodes is complete and the cluster is fully operational. You can now install the Interplay Engine.

**Installing the Interplay Engine**

When you are ready to start installing the Interplay Engine, make sure you have the Preflight Checklist with your networking information available (see “Preflight Checklist” on page 57. During the software installation you will be prompted to enter the following cluster-related information:

- Virtual IP Address
- Subnet Mask
- Public Network Name
- Cluster Name
- Interplay Engine Virtual Name
- NXN Server Execution Username and Password

See the following topics:

- “Preparation for Installing on Node 1” on page 92
- “Install the Interplay Engine Software on Node 1” on page 92
- “Check the Status of the Cluster Role” on page 100
- “Install the Avid Interplay Engine Software on Node 2” on page 101
- “Bring the Interplay Engine Cluster Online” on page 102
Preparation for Installing on Node 1

To prepare for the engine installation, make sure that the shared database drive (S:) is online.

To bring the shared database drive online:

1. Shut down node 2.
2. Right-click This PC and select Manage. From the Tools menu, select Computer Management. In the Computer Management list, select Storage > Disk Management.
3. Right-click the disk designated to be the S: Database drive (Disk 2) and select Online. This volume should reflect the size (800 GB) set previously.
4. Make sure the drive letter is correct (S:) and the drive is named Database. If not, you can change it here.

   a. Right-click the disk and select Change Drive Letter or Path.
   b. Click Change.
   c. Select S: as the drive letter. You receive a warning telling you that some programs that rely on drive letters might not run correctly and asking if you want to continue.
   d. Click Yes.

Install the Interplay | Engine Software on Node 1

To install the Interplay Engine software on node 1:

1. Make sure the second node is shut down.
2. At the root level of the D: partition of node1, create a folder and name it Avid Installers.
3. Copy the Interplay Server Installer file to the Avid Installers folder.

   All your software installers and utilities should be stored and logically organized on a vmdk file.
4. Start the Avid Interplay Servers installer. 
   A start screen opens.
5. Select the following from the Interplay Server Installer Main Menu:
   Servers > Avid Interplay Engine > Avid Interplay Engine
   The Welcome dialog box opens.
6. Click Next.
   The License Agreement dialog box opens.
7. Select “I accept the agreement.” and click Next.
   The Specify Installation Type dialog box opens.
8. In the Specify Installation Type dialog box, select Custom.

![Specify Installation Type](image)

9. Click Next.
   The Specify Cluster Mode dialog box opens.

![Specify Cluster Mode](image)
10. Select Cluster and click Next to continue the installation in cluster mode. The Specify Interplay Engine Details dialog box opens.

11. Type the following values:
   - Virtual IP address: Enter the ip address assigned to the Interplay Engine’s Virtual Name.
   - Subnet Mask: The subnet mask of your Public Network.
   - Public Network: Public (The name of your Network Interface Port for your Public Network)
   - Shared Drive: S: (The drive letter assigned to the disk for the Interplay database)

12. Click Next.
   The Specify Interplay Engine Name dialog box opens.

13. Enter the Interplay Engine Virtual Name for both fields.
14. Click Next.
    The Specify Destination Location dialog box opens.

15. Keep the default path C:\Program Files\Avid\Avid Interplay Engine.
16. Click Next.
    The Specify Default Database Folder dialog box opens.

17. Make sure the path specifies the shared drive (S:).
18. Click Next.
    The Specify Share Name dialog box opens.
19. Verify that the dialog box contains the default share name WG_Database$.
20. Click Next.

This step takes a few minutes to complete. When finished the Specify Configuration Server dialog box opens.

21. Select the server to act as the Central Configuration Server.

The Central Configuration Server (CCS) is an Avid Interplay Engine with a special module that is used to store server and database-spanning information. Typically you are working with only one server, so the appropriate choice is “This Avid Interplay Engine,” which is the default.

If you need to specify a different server as the CCS (for example, if an Interplay Archive Engine is being used as the CCS), select “Another Avid Interplay Engine.” You need to type the name of the other server to be used as the CCS in the next dialog box.
22. Click Next.
The Specify Server User dialog box opens.

```
Specify Server User
```

23. Enter the Server Execution Username and its password.

The Server Execution User is the Windows domain user that should have been created previously as part of completing the Preflight Checklist.

⚠️ **When typing the domain name do not use the full DNS name such as mydomain.company.com, because the DCOM part of the server will be unable to start. You should use the NetBIOS name, for example, mydomain.**

⚠️ **The installer cannot check the username or password you type in this dialog. Make sure that the password you enter is correct.**

24. Click Next.

The Specify Preview Server Cache dialog box opens.
25. Specify the path for the cache folder. Typically, use the default path of S:\Workgroup_Database\PreviewServer.

26. Click Next.

The Enable Email Notification dialog box opens.

The email notification feature sends emails to your administrator when special events, such as “Cluster Failure,” “Disk Full,” and “Out Of Memory” occur. Activate email notification if you want to receive emails on special events, server or cluster failures.

If you do not want to enable email notification, do not select the option “Enable email notification on server events.” Click Next.
If you do want to enable email notification, complete the following steps:

a. (Optional) Select “Enable email notification on server events.”
   The Email Notification Details dialog box opens.

   ![Email Notification Details dialog box]

   - **Recipient email address:** administrator@mydomain.com
   - **Sender email address:** WorkgroupServer@mydomain.com
   - **SMTP server IP:** 122.123.123.123

   b. Type the administrator's email address and the email address of the server, which is the sender. You also need to type the static IP address of your SMTP server. If you do not know this IP, ask the site administrator.

   c. Click Next.
   The Ready to Install dialog box opens. Use the Back button to review or change the data you entered. You can also terminate the installer using the Cancel button, because no changes have been done to the system yet.

   ![Ready to Install dialog box]

   27. If all the information entered is accurate, click Next.
The Ready to Install dialog box is displayed.

28. Click Continue.

The Installation Completed dialog box opens when the installation is finished and displays the success or failure of each component installation. Use the scroll bar to verify that the installation status is OK for all line items.

29. Click Finish.

30. Click OK if prompted for a restart the system.

**Check the Status of the Cluster Role**

After installing the Interplay Engine on node 1, check the status of the resources in the Avid Workgroup Server cluster role.

**To check the status of the cluster role:**

1. After the installation is complete, right-click My Computer and select Manage.
   The Server Manager window opens.
2. In the Server Manager list, open Features > Failover Cluster Manager > cluster_name.
3. Click Roles.
   The Avid Workgroup Server role is displayed.
4. Click the Resources tab.
   The list of resources should look similar to those in the following illustration.
In the bottom pane, the following resources should show the Online status:

- Avid Workgroup Disk
- Avid Workgroup Server Name (not Avid Workgroup Server in the top pane)
- File Server

**Install the Avid Interplay Engine Software on Node 2**

To install the Interplay Engine on node 2:

1. Leave the node 1 running so that it maintains ownership of the cluster role and start node 2.
2. Start the installation procedure for node 2 as described in “Install the Interplay Engine Software on Node 1” on page 92.

   The Attention dialog box opens.
3. Confirm that the information is accurate and click OK.

4. Proceed through the installation. Enter the identical IP address and hostnames you entered for node1 because they are virtual names used by both node1 and node2.

5. Node 2 might require one or two restarts during the installation process. After any restarts, simply log back into the machine.

**Bring the Interplay | Engine Cluster Online**

When the installations on both node1 and node2 are complete, you can bring the Avid Workgroup Server online and create the Interplay database.

**To bring the Interplay Engine online:**

1. Open the Failover Cluster Manager and select `cluster_name > Roles`.

   The Avid Workgroup Server role is displayed.

2. Select Avid Workgroup Server, and in the Actions list, select Start Role.

   All resources are now online, as shown in the following illustration. To view the resources, click the Resources tab.
After Installing the Interplay | Engine

After you install the Interplay Engine, install the following applications on both nodes:

- Avid ISIS client (if not already installed): See the Avid ISIS System Setup Guide.

If you cannot log in or connect to the Interplay Engine, make sure the database share WG_Database$ exists. You might get the following error message when you try to log in: “The network name cannot be found (0x80070043).”

Then create an Interplay database, as described in the next topic.

Create an Interplay | Production Database

Before testing the failover cluster, you need to create a database. The following procedure describes basic information about creating a database. For complete information, see the Interplay | Engine and Interplay | Archive Engine Administration Guide.

To create an Interplay database:

1. Start the Interplay Administrator and log in.
2. In the Database section of the Interplay Administrator window, click the Create Database icon.
   The Create Database view opens.
3. In the New Database Information area, leave the default “AvidWG” in the Database Name text box. For an archive database, leave the default “AvidAM.” These are the only two supported database names.

4. Type a description for the database in the Description text box, such as “Main Production Server.”

5. Select “Create default Avid Interplay structure.”

After the database is created, a set of default folders within the database are visible in Interplay Access and other Interplay clients. For more information about these folders, see the Interplay | Access User’s Guide.

6. Keep the root folder for the New Database Location (Meta Data).
   The metadata database must reside on the Interplay Engine server.

7. Keep the root folder for the New Data Location (Assets).

8. Click Create to create directories and files for the database.
   The Interplay database is created.

---

**Test the Complete Installation**

After you complete all the previously described steps, you are now ready to test the installation. Make yourself familiar with the Failover Cluster Manager and review the different failover-related settings.

*If you want to test the Microsoft cluster failover process again, see “Test the Cluster Installation” on page 89.*

**To test the complete installation:**

1. Bring the Interplay Engine online, as described in “Bring the Interplay | Engine Cluster Online” on page 102.

2. Make sure you created a database (see “Create an Interplay | Production Database” on page 103).
   You can use the default license for testing. Then install the permanent licenses, as described in “Install a Permanent License” on page 105


4. Start the second node, if it is not already running.

5. In the Failover Cluster Manager, initiate a failover by selecting Avid Workgroup Server and then selecting Move > Best Possible Node from the Actions menu. Select another node.
   After the move is complete, all resources should remain online and the target node should be the current owner.
   You can also simulate a failure by right-clicking a resource and selecting More Actions > Simulate Failure.

*A failure of a resource does not necessarily initiate failover of the complete Avid Workgroup Server role.*

6. You might also want to experiment by terminating the Interplay Engine manually using the Windows Task Manager (NxNServer.exe). This is also a good way to get familiar with the failover settings which can be found in the Properties dialog box of the Avid Workgroup Server and on the Policies tab in the Properties dialog box of the individual resources.
7. Look at the related settings of the Avid Workgroup Server. If you need to change any configuration files, make sure that the Avid Workgroup Disk resource is online; the configuration files can be found on the resource drive in the Workgroup_Data folder.

Install a Permanent License

During Interplay Engine installation a temporary license for one user is activated automatically so that you can administer and install the system. There is no time limit for this license.

Starting with Interplay Production v3.3, new licenses for Interplay components are managed through software activation IDs. In previous versions, licenses were managed through hardware application keys (dongles). Dongles continue to be supported for existing licenses, but new licenses require software licensing.

To install a permanent license through software licensing:
1. Use the Avid License Control application to install the license on node 1.
   See “Software Licensing for Interplay Production” in the Interplay Production Software Installation and Configuration Guide.
2. Repeat the installation process on node 2.

For more information on managing licenses, see the Interplay | Engine and Interplay | Archive Engine Administration Guide.

Configure the Cluster for a vSphere HA and vSphere DRS Environment

When you use MSCS in a vSphere High Availability (vSphere HA) or vSphere Distributed Resource Scheduler (DRS) environment, you must configure your hosts and virtual machines to use certain settings. All hosts that run MSCS virtual machines must be managed by a vCenter Server system.

These tasks are described in the following topics:
- “Enable vSphere HA and vSphere DRS in the Cluster” on page 105
- “Create VM-VM Anti-Affinity Rules for MSCS Virtual Machines” on page 106
- “Enable Strict Enforcement of Anti-Affinity Rules (MSCS)” on page 106
- “Set DRS Automation Level for MSCS Virtual Machines” on page 107

Enable vSphere HA and vSphere DRS in the Cluster

All hosts that are running MSCS virtual machines can be part of a vCenter Server cluster with both vSphere HA and vSphere DRS enabled. You can enable vSphere HA and vSphere DRS in the Cluster Settings dialog box.

To enable vSphere HA and vSphere DRS:
1. Browse to the cluster in the vSphere Web Client object navigator.
2. Click the Manage tab and click Settings.
3. Under Services, click Edit.
Configure the Cluster for a vSphere HA and vSphere DRS Environment

4. Select the “Turn ON vSphere HA” and “Turn ON vSphere DRS” check boxes.
5. Click OK.

Create VM-VM Anti-Affinity Rules for MSCS Virtual Machines

For MSCS virtual machines in a cluster, you must create VM-VM affinity or anti-affinity rules. VM-VM affinity rules specify which virtual machines should be kept together on the same host (for example, a cluster of MSCS virtual machines on one physical host). VM-VM anti-affinity rules specify which virtual machines should be kept apart on different physical hosts (for example, a cluster of MSCS virtual machines across physical hosts).

For a cluster of virtual machines across physical hosts, use anti-affinity rules.

vMotion is supported only for a cluster of virtual machines across physical hosts with pass-through RDMs. For a cluster of virtual machines on one physical host and a cluster of virtual machines across physical hosts with non-pass-through RDMs, vMotion is not supported.

To create anti-affinity rules:
1. Browse to the cluster in the vSphere Web Client navigator.
2. Click the Manage tab.
3. Click Settings, and click Rules.
4. Click Add.
5. In the Rule dialog box, type a name for the rule.
6. From the Type drop-down menu, select a rule.
7. For a cluster of virtual machines across physical hosts, select Separate Virtual Machines.
8. Click Add.
9. Select the two virtual machines to which the rule applies and click OK.
10. Click OK.

Enable Strict Enforcement of Anti-Affinity Rules (MSCS)

To ensure that affinity and anti-affinity rules are strictly applied, set an advanced option for vSphere DRS. Setting the advanced option “ForceAffinePoweron” to “1” will enable strict enforcement of the anti-affinity rules that you created.

To enable strict enforcement of anti-affinity rules:
1. Browse to the cluster in the vSphere Web Client navigator.
2. Click the Manage tab.
3. Click Settings, and under vSphere DRS click Edit.
4. Expand Advanced Options and click Add.
5. In the Option column, type ForceAffinePoweron.
6. In the Value column, type 1.
7. Click OK.
Set DRS Automation Level for MSCS Virtual Machines

You must set the automation level of all virtual machines in an MSCS cluster to Partially Automated. When you set the vSphere DRS automation level for the virtual machine to Partially Automated, vCenter Server will perform initial placement of virtual machines when they are powered on and will provide migration recommendations for them.

To set DRS automation level:
1. Browse to the cluster in the vSphere Web Client object navigator.
2. Click the Manage tab and click Settings.
3. Under Services, click Edit.
4. Expand DRS Automation, under Virtual Machine Automation select the “Enable individual virtualmachine automation levels” check box and click OK.
5. Under Configuration, select VM Overrides and click Add.
6. Click the + button, select the MSCS virtual machines in the cluster and click OK.
7. Click the Automation level drop-down menu, and select Partially Automated.
8. Click OK.

VMware recommends partially automated mode for MSCS virtual machines, but there is no technical restriction which prevents the setting for MSCS virtual machines to be fully automated. If the fully automated setting is used please tune the migration threshold to suit the workload running on the MSCS virtual machines.